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Overview

Introduction

CallPilot Part 5: 1001rp Server Maintenance and Diagnostics provides 
information and instructions for maintaining a CallPilot server, as well as 
troubleshooting tips for potential problems.

Who should read this guide

This guide is for planners, administrators, technicians, and engineers respon
for maintaining a CallPilot server. 

It includes information for installing, repairing, replacing, and upgrading 
hardware and software components. The guide assumes that the reader:

� has basic computing skills

� is familiar with necessary safety procedures

� has the hardware documentation provided by the manufacturer availab
a reference

� is maintaining or troubleshooting an existing CallPilot server.

Glossary and Related Guides

Part 1 of this binder contains a glossary and a list of related guides.
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Skills you need

Introduction

This section describes the skills and knowledge you need to use this guide 
effectively.

PC experience or knowledge

Knowledge of, or experience with, the following PC products will be of 
assistance when administering the CallPilot server:

� Microsoft Windows 95 or Windows NT

� client/server architecture

� Internet Protocol (IP)

Other experience or knowledge

Other types of experience or knowledge that can be of use include:

� database management

� programming
Part 5: 1001rp Server Maintenance and Diagnostics 15
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Structure of this guide

Introduction

CallPilot Part 5: 1001rp Server Maintenance and Diagnostics defines the 
hardware and software diagnostic and recovery activities that a support 
technician should perform. 

The first five chapters of this guide describe the tools that are available for 
identifying, diagnosing, and fixing hardware problems. If a problem is 
discovered, Chapter 6 provides procedures for removing the malfunctioning
hardware component and upgrading or installing a new component. 

If the problem is software-related, Chapters 7 and 8 describe the procedure
installing the server software in a recovery situation. 

Regular server maintenance procedures are described in Chapters 9 and 1

If required, the procedures for uninstalling and reinstalling the server softwa
are described in Chapters 11 and 12. 

The last chapter provides procedures for recovering from a hard drive failur
16 CallPilot
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Symbols and conventions

Introduction

This section describes the symbols and conventions used in this guide.

Symbols

You might encounter the following symbols in this manual.

. 

DANGER

Risk of electric shock
Warns you of an immediate electrical hazard that, if not 
avoided, will result in shock, serious injury, or death.

. 

WARNING

Risk of personal injury
Warns you of a situation in which you can be injured if 
instructions are not followed exactly as stated.
Part 5: 1001rp Server Maintenance and Diagnostics 17
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Note: Describes the secondary results of procedures or commands, or spec
conditions under which a procedure or command must be used.

. 

CAUTION

Risk of equipment damage

Alerts you to situations where data can be lost or damage
equipment can be damaged, actions can result in service
interruption, and productive time can be lost.

ATTENTION Provides information essential to the completion of a 
task.
18 CallPilot
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Preparing for maintenance activities

Introduction

Perform maintenance activities to ensure the proper functioning of your ser
or to fix any problems that occur. Before you begin any maintenance activiti
collect the tools you need and follow recommended safety precautions.

This section discusses the tools and equipment required for performing 
maintenance procedures in the field. Recommended safety precautions for
electrostatic discharge, handling cards, and handling your server are also 
included.
Part 5: 1001rp Server Maintenance and Diagnostics 19
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Required tools and safety precautions

Introduction

If you need to replace or upgrade any system parts, follow Nortel Networks t
and safety guidelines to prevent personal injury and damage to the server o
replacement parts.

Maintenance tools and materials checklist

Use this checklist for the tools and materials you need to perform maintena
and diagnostics tasks.  

. 

WARNING

Risk of personal injury and equipment damage
Field maintenance must always be performed by fully 
qualified, trained personnel.

Check Description

Phillips cross-head screwdriver 

Standard slot-head screwdriver (1/4" and 1/2")

Sidecutters

Jumper removal tool or needle nose pliers

Tape measure for determining cable lengths

Tweezers

Antistatic ESD wrist strap (recommended)

Pen or pencil for writing notes, cable lengths, and cable 
identifications

Flashlight for examining interior of chassis

Cable tie wraps
20 CallPilot
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Approved replacement parts

Before replacing any parts on your server, contact your Nortel Networks 
customer support representative for a list of approved add-in boards and 
peripheral devices. The use of non-approved replacement parts can cause s
system problems or void your Nortel Networks warranty.

Pen or pencil for noting cable lengths and labeling cables

Head-cleaning tape kit

Cable identification labels

Equipment log. This is used to record the model and serial
number of the system, all installed options, and other 
information.

Windows NT emergency disk. This contains the configuratio
data for Windows NT.

Windows NT 4.0 Setup disks. The three disks are used for 
reinstalling the operating system.

Microsoft DOS 6.20 disks. These three disks are used for 
reinstalling the operating system for maintenance and 
diagnostics.

A package of blank disks.

Intel Ethernet LAN Adapter Driver disk

Keycode data. This governs what software features you wi
be installing.

pcANYWHERE32 software. This will be used to allow 
remote access by Nortel Networks service. It is on the MAS
2.0 Operating System CD-ROM.

RAID driver disk and configuration disk (optional)

Check Description
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General safety

Nortel Networks recommends that you observe these safety guidelines as y
work on your server:

� Plug the computer and peripheral devices into properly grounded powe
sources to prevent electric shock.

� Use a surge protector or uninterruptible power supply to protect your 
system from sudden increases and decreases in electrical power.

� Ensure that nothing rests on your server’s cables and that cables cann
tripped over or stepped on.

� Do not handle food or liquid around the server.

� Do not push any objects into the openings of your server.

Safety precautions for working with your server

Observe these safety guidelines before removing the top cover of your serv

1. Turn off all peripheral devices connected to the server.

2. Turn off the system by using the push-button on/off power switch. Unpl
the AC power cord from the system or wall outlet.

3. Label and disconnect all peripheral cables and all telecommunication l
connected to the I/O connectors or ports on the back of the system.

4. Provide electrostatic discharge (ESD) protection by wearing an antista
wrist strap attached to the chassis ground of the system when handling
components. Attach your wrist strap to any unpainted metal surface.

Cooling and airflow

For proper cooling and airflow, always install the chassis top cover before 
turning on the system. You risk damaging system parts if you operate the sy
without the cover in place.
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Avoiding electrostatic discharge

Introduction

Electrostatic discharge (ESD) can seriously damage component parts such
disk drives, boards, and other parts. Nortel Networks recommends that you
perform the maintenance procedures described in this section at an ESD 
workstation.

Antistatic wrist strap

If an ESD workstation is not available, provide some ESD protection by wea
an antistatic wrist strap. Ground the ESD wrist strap by attaching it to any 
unpainted surface on your system chassis.

While you work

As you work inside the server, periodically touch an unpainted surface to 
discharge any static your body might have accumulated.

Conductive foam padded in-boards

Expansion cards are extremely sensitive to ESD. After removing a card from
protective wrapper or from the system, place it component-side up on a 
conductive foam pad. If possible, use antistatic floor pads and workbench p
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Handling cards

Introduction

Electronic components are sensitive to the environment and to electrostatic
discharge. To protect equipment and prolong the useful life of components,
Nortel Networks recommends that you follow the precautions described bel

Avoiding electrostatic discharge

Electrostatic discharge (ESD) affects the performance and decreases the u
life of system components. Use caution when handling Error Code Correcti
(ECC) memory modules, SBC cards, and add-in boards to prevent damage
Wear an ESD wrist strap when handling system parts.

Precautions for handling cards

Take these precautions with any procedure that includes an add-in board:

� After removing a board from its protective wrapper or from the server, 
place it component-side up on a grounded, static-free surface.

� Do not slide a board over any surface.

� Do not touch board components or gold-edge connectors on the board

� Hold a board by the top edge, or by the side edges.

Installing boards

When installing boards on the server, remember the following details:

� The backplane is flexible and supported with stand-offs.

� Board slots resist connector insertion.

� Firm, steady force seats a board in its slot properly.

� Boards seat with friction followed by a solid stop.

� External connector plates, attached to add-in boards, are seated in the
panel and secured with a screw.
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Handling hard disks

Introduction

Hard disks are extremely sensitive to vibration and physical shock. To prote
equipment and prolong the life of hard drives, Nortel Networks recommends
following precautions.

Avoid vibration or physical shock

Hard disks are susceptible to even slight vibrations. A hard disk can be dam
if it is placed on a table that is accidently knocked or moved. Use caution w
handling hard disks to prevent damage.

Precautions for handling hard disks

After removing a hard disk from its protective wrapper, or from the server, pl
it on an antistatic, padded workbench or workstation to avoid movement or 
jarring.

Shipping damage

If your hard disk is shipped independently for either an upgrade or a 
replacement, note any dents or damage on the padded container and pack
Keep the container to prove that the part was damaged during shipping and
handling.

Remove hard drives

The drives are hot-swappable and can be removed without a system shutd

Store hard drives

If you purchase extra hard disks, store these hard disks in the original padd
container. Store the disks away from places where they might be moved or
jarred.
Part 5: 1001rp Server Maintenance and Diagnostics 25
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Handling CD-ROM disks

Introduction

When removing a CD-ROM disk from its protective case or loading a disk to
drive, hold it by its center hole and outer edge. Avoid touching the disk’s da
surface (the non-labeled side).

To protect a disk against scratches and dirt when not in use, keep it in its 
protective case.

To load a CD-ROM disk

1 Press the eject button on the CD-ROM drive to eject the disk tray.

2 Place the disk on the tray with its labeled side facing up.

3 Press the eject button or gently press the front of the disk tray to retract the 
tray back into the drive.

To eject a CD-ROM disk

1 Press the eject button on the CD-ROM drive to eject the disk tray.

2 Remove the disk from the tray and put it in its protective case.

3 Press the eject button or gently press the front of the disk tray to retract the 
tray back into the drive.
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In this chapter 
 Overview 28

 Starting up the server 29

 Shutting down the server 30
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Overview

Introduction

This chapter provides procedures for

� turning on the peripheral devices and the server, and verifying proper 
startup. See “Starting up the server” on page 29.

� shutting down the server if you need to install, reinstall, or replace hardw
components. See “Shutting down the server” on page 30.
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Starting up the server

To turn on the system

1 Ensure the modem power switch is on.

2 Turn the monitor power switch on.

3 Press the server power switch on.

4 Observe the Power-On Self-Test (POST) and initialization messages as the 
server starts.

 Startup sequence

The following is the sequence for the server startup:

To interpret the POST beep codes that your CallPilot emits, refer to “Interpreting 
POST diagnostics” on page 38.

Stage Description

1 POST messages appear.

2 SCSI (or RAID) initialization messages appear. 

3 Allow selection of Windows NT/DOS.

4 Server boots to DOS. Runs High Memory Test and PC Diags.

5 Server boots to Windows NT and displays the logon screen.

6 Press Ctrl + Alt + Delete.

7 Log on as the administrator with the appropriate password
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Shutting down the server

Introduction

Any time you need to power down the server, follow the procedure in this 
section.

To shutdown the server

1 Press the Ctrl, Alt, and Delete keys simultaneously.

Result: The Windows NT Security dialog box appears.

2 Select Shutdown.

Result: The Shutdown Computer dialog box appears.

3 Select Shutdown.

4 Click OK.

Result: The Shutdown Computer window displays the message It is 
now safe to turn off your computer .

a. You might be informed that an SQLAnywhere service is running with 
connections, and asked if you want to end it.

b. Click Yes or End Task. 

Result: You might also be asked if you want to save ACD proxy 
changes.

c. Click No.
30 CallPilot



C h a p t e r  3

Diagnostics

In this chapter
 Overview 32
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 Running the confidence test 34

Section B: Startup diagnostics 35

 Startup diagnostics overview 36

 Power-On Self-Test diagnostics 37

 Interpreting POST diagnostics 38

 Interpreting startup diagnostics from SCSI BIOS 45

Section C: Performing Windows NT online diagnostics 47
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 Checking hardware using Windows NT 4.0 diagnostics 49

 Invoking the chkdsk utility 53
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 Invoking and interpreting Token Ring card diagnostics 67
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 Shutting down services 71

 Conducting TSTSERIO tests 73

 Conducting TSTSERIO tests with the loopback plug 77

 Restarting services 78
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Overview

Introduction

This chapter includes the following information:

� Section A: “System diagnostics” on page 33 for running the confidence

� Section B: “Startup diagnostics” on page 35 for help in interpreting the 
startup diagnostics on the 1001rp server

� Section C: “Performing Windows NT online diagnostics” on page 47 to 
help you use the run-time diagnostics provided by the Windows NT ser
software

� Section D: “Invoking and interpreting serial port diagnostics” on page 6
for running serial port diagnostics using the TSTERIO command
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Section A: System diagnostics
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Running the confidence test

Introduction

The following procedure and results are specific to the 1001rp server.

To run the confidence test

1 Power on the server and observe the front panel display.

Result: All LEDs on the panel illuminate for a few seconds. The green 
power LED remains illuminated.

2 Observe the following server actions:

� Cooling fans on the front panel start up, and the red fault LED next to 
each fan extinguishes.

� Drives spin up, and the amber hard drive activity LEDs over the front 
panel display, extinguish, and then flash with activity.

� LEDs illuminate temporarily as the system checks the floppy drive, tape 
drive, and CD-ROM drive.

� The LED on each power supply lights up red as supply fans spin up and 
components charge. LEDs turn green when the attached power supply 
is fully operational.

3 Check the monitor as the server counts RAM and completes a Power-On 
Self-Test (POST).

Result: A descriptive prompt appears on the monitor.
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In this section
Startup diagnostics overview 36

Power-On Self-Test diagnostics 37

 Interpreting POST diagnostics 38

 Interpreting startup diagnostics from SCSI BIOS 45
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Startup diagnostics overview

Introduction

This module contains procedures for interpreting the startup diagnostics on
1001rp server.

Startup diagnostics are available only when you boot to DOS or when you f
install a system.

Startup diagnostic classes

Two classes of startup diagnostics are available on the server:

� Power-On Self-Test (POST) diagnostics

� SCSI controller diagnostics

or

� RAID controller diagnostics

These diagnostics are available at initial system startup, or after any 1001rp
server reset.
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Power-On Self-Test diagnostics

Definition

The Power-On Self-Test (POST) is a system diagnostic program (stored in 
BIOS) that runs every time the 1001rp server is started. POST’s function is 
test system components and then display status messages.

POST message formats

POST reports on the system status in three ways:

� POST beep codes

� POST error codes and messages

� countdown codes displayed during normal BIOS POST
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Interpreting POST diagnostics

Introduction

This section provides an explanation of the POST diagnostic codes. 

POST beep codes

If an error occurs before video initialization, POST emits beep codes that 
indicate errors in hardware, software, or firmware. 

A beep code is a series of separate tones, each equal in length. Write down
beep code sequence before calling Nortel Networks technical support. 

ATTENTION
Some POST beep codes are fatal and require that you
replace the SBC. See the table below for more 
information about beep codes.

Beep sequence Error message and conditions

1-2-2-3 Checksum the BIOS.

1-3-1-1 Verify proper refresh operation.

1-3-4-1 Test the DRAM address lines.

1-3-4-3 Test the base memory.

1-4-1-1 Test lower memory.

2-1-2-3 Verify that the copyright message is intact.

2-2-3-1 Check for any pending hardware interrupts (there should be 
none).

1-2 ROM checksum error; no/faulty video card. Initialize all ISA 
and PCI option ROMs.

1 One short beep before boot.

Beep the speaker.
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POST error codes and messages

The BIOS indicates errors through POST by displaying a POST diagnostic 
on the screen.

The following chart lists the on-screen POST error codes and messages:

Beep code POST code Description / test point

1-1-1-3 02 Verify Real Mode

1-1-2-1 04 Get CPU type

1-1-2-3 06 Initialize System Hardware

1-1-3-1 08 Initialize chipset registers with initial POST values

1-1-3-2 09 Set in POST flag

1-1-3-3 0A Initialize CPU registers

1-1-4-1 0C Initialize cache to initial POST values

1-1-4-3 0E Initialize I/O

1-2-1-1 10 Initialize Power Management

1-2-1-2 11 Load alternate registers with initial POST values

1-2-1-3 12 Jump to UserPatch0

1-2-2-1 14 Initialize keyboard controller

1-2-2-3 16 BIOS ROM checksum

1-2-3-1 18 8254 timer initialization

1-2-3-3 1A 8237 DMA controller initialization

1-2-4-1 1C Reset Programmable Interrupt Controller

1-3-1-1 20 Test DRAM refresh

1-3-1-3 22 Test 8742 Keyboard controller

1-3-2-1 24 Set ES segment to register to 4 Gbytes
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1-3-3-1 28 Autosize DRAM

1-3-3-3 2A Clear 512 kbytes base RAM

1-3-4-1 2C Test 512 base address lines

1-3-4-3 2E Test 512 kbytes base memory

1-4-1-3 32 Test CPU bus-clock frequency

1-4-2-1 34 CMOS RAM read/write failure (this commonly 
indicates a problem on the ISA bus, such as a car
not seated correctly)

1-4-2-4 37 Reinitialize the chipset

1-4-3-1 38 Shadow system BIOS ROM

1-4-3-2 39 Reinitialize the cache

1-4-3-3 3A Autosize cache

1-4-4-1 3C Configure advanced chipset registers

1-4-4-2 3D Load alternate registers with CMOS values

2-1-1-1 40 Set Initial CPU speed

2-1-1-3 42 Initialize interrupt vectors

2-1-2-1 44 Initialize BIOS interrupts

2-1-2-3 46 Check ROM copyright notice

2-1-2-4 47 Initialize manager for PCI Options ROMs

2-1-3-1 48 Check video configuration against CMOS

2-1-3-2 49 Initialize PCI bus and devices

2-1-3-3 4A Initialize all video adapters in system

2-1-4-1 4C Shadow video BIOS ROM

2-1-4-3 4E Display copyright notice

Beep code POST code Description / test point
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2-2-1-1 50 Display CPU type and speed

2-2-1-3 52 Test keyboard

2-2-2-1 54 Set key click if enabled

2-2-2-3 56 Enable keyboard

2-2-3-1 58 Test for unexpected interrupts

2-2-3-3 5A Display prompt “Press F2 to enter SETUP”

2-2-4-1 5C Test RAM between 512 and 640 kbytes

2-3-1-1 60 Test expanded memory

2-3-1-3 62 Test extended memory address lines

2-3-2-1 64 Jump to UserPatch1

2-3-2-3 66 Configure advanced cache registers

2-3-3-1 68 Enable external and CPU caches

2-3-3-2 69 Initialize SMI handler

2-3-3-3 6A Display external cache size

2-3-4-1 6C Display shadow message

2-3-4-3 6E Display non-disposable segments

2-4-1-1 70 Display error messages

2-4-1-3 72 Check for configuration errors

2-4-2-1 74 Test real-time clock

2-4-2-3 76 Check for keyboard errors

2-4-4-1 7C Set up hardware interrupts vectors

2-4-4-3 7E Test coprocessor if present

3-1-1-1 80 Disable onboard I/O ports

Beep code POST code Description / test point
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3-1-1-3 82 Detect and install external RS-232 ports

3-1-2-1 84 Detect and install external parallel ports

3-1-2-3 86 Reinitialize onboard I/O ports

3-1-3-1 88 Initialize BIOS Data Area

3-1-3-3 8A Initialize Extended BIOS Data Area

3-1-4-1 8C Initialize floppy controller

3-2-1-1 90 Initialize hard-disk controller

3-2-1-2 91 Initialize local-bus hard-disk controller

3-2-1-3 92 Jump to UserPatch2

3-2-2-1 94 Disable A20 address line

3-2-2-3 96 Clear huge Es segment register

3-2-3-1 98 Search for option ROMs

3-2-3-3 9A Shadow option ROMs

3-2-4-1 9C Set up Power Management

3-2-4-3 9E Enable hardware interrupts

3-3-1-1 A0 Set time of day

3-3-1-3 A2 Check key lock

3-3-3-1 A8 Erase F2 prompt

3-3-3-3 AA Scan for F2 key stroke

3-3-4-1 AC Enter SETUP

3-3-4-3 AE Clear in-POST flag

3-4-1-1 B0 Check for errors

3-4-1-3 B2 POST done — prepare to boot operating system

Beep code POST code Description / test point
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3-4-2-1 B4 One beep

3-4-2-3 B6 Check password (optional)

3-4-3-1 B8 Clear global descriptor table

3-4-4-1 BC Clear parity checkers

3-4-4-3 BE Clear screen (optional)

3-4-4-4 BF Check virus and backup reminders

4-1-1-1 C0 Try to boot with INT 19

4-2-1-1 D0 Interrupt handler error

4-2-1-3 D2 Unknown interrupt error

4-2-2-1 D4 Pending interrupt error

4-2-2-3 D6 Initialize option ROM error

4-2-3-1 D8 Shutdown error

4-2-3-3 DA Extended Block Move

4-2-4-1 DC Shutdown 10 error

4-2-4-3 DE Keyboard Controller Failure (most likely problem 
is with RAM or cache unless no video is present)

4-3-1-3 E2 Initialize the chipset

4-3-1-4 E3 Initialize refresh counter

4-3-2-1 E4 Check for Forced Flash

4-3-2-2 E5 Check HW status of ROM

4-3-2-3 E6 BIOS ROM is OK

4-3-2-4 E7 Do a complete RAM test

4-3-3-1 E8 Do OEM initialization

Beep code POST code Description / test point
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4-3-3-2 E9 Initialize interrupt controller

4-3-3-3 EA Read in bootstrap code

4-3-3-4 EB Initialize all vectors

4-3-4-1 EC Boot the Flash program

4-3-4-2 ED Initialize the boot device

4-3-4-3 EE Boot code was read OK

Beep code POST code Description / test point
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Interpreting startup diagnostics from SCSI 
BIOS

Introduction

The results from the SCSI controller diagnostics appear after the POST res

Applicable cards

Results of the startup diagnostics appear only if you have the following ada
cards installed on your system:

� Adaptec SCSI controller

The adapter is integrated in the SBC and can be disabled.

� Mylex RAID adapter

The RAID adapter is optional.
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Section C: Performing Windows NT 
online diagnostics

In this section
 Overview 48

 Checking hardware using Windows NT 4.0 diagnostics 49

 Invoking the chkdsk utility 53

 Invoking and interpreting TCP/IP diagnostics 55

 Invoking and interpreting Token Ring card diagnostics 67
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Overview

Introduction

This section outlines how to access the run-time online diagnostics provide
the Windows NT server software.
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Checking hardware using Windows NT 4.0 
diagnostics

Introduction

The Windows NT 4.0 system provides tools that can be used to diagnose a
debug system problems, including

� Windows NT Diagnostics screen

� Event Viewer

Windows NT Diagnostics window

The Windows NT 4.0 Diagnostics window allows you to view details 
concerning the system and network components. 

You can open the following tabs on the Diagnostics window to display spec
information: 

� Version 
� System
� Display
� Drives
� Memory
� Services
� Resources
� Environment
� Network
Part 5: 1001rp Server Maintenance and Diagnostics 49



Diagnostics  Standard 1.0
 Windows NT Diagnostics main window

To access Windows NT 4.0 diagnostic tools

1 Log on to Windows.

2 Select Start > Programs > Administrative Tools (Common) > Windows NT 
Diagnostics to access the Windows NT Diagnostics window.

3 Select the appropriate tab on the Diagnostics main window to view 
information concerning the system and network. Details available on each 
tab are supplied in the following table:
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Select To display details about

Version Version
Registration

System System identifier
HAL
BIOS information
Processors

Display BIOS information
Adapter
Driver

Drives Drives by type or letter

To view specific details, select a drive, and then press 
Properties to view details for the drive, including size, 
labels, and so on.

Memory Memory, including totals, physical and kernel 
memory, commit charge, kernel

Services Service and state for both services and devices

To view specific details, select a service, and then 
press Properties to view details, including pathname, 
dependencies, service flags, and so on.

Resources Select one of the following buttons to display 
information about the resources available on the 
system:

IRQ

I/O Port

DMA

Memory 

Devices

To view specific details, select a resource, and then 
press Properties.
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Event Viewer

Windows NT 4.0 provides an Event Viewer that is used to view event logs to
assist in diagnosing and debugging system problems.

Three types of event logs are available from the Event Viewer, as follows:

To access the Event Viewer

1 Log on to Windows.

2 Select Start > Programs > Administrative Tools (Common) > Event Viewer.

3 Select the appropriate tab to view the associated event logs.

Environment Variable and value for both system and local user

������� ��	�
� ��� �
 ��� 
�		����� ������� �� ����	��

��
�������� ����� ��� ������� ��� 
����������

� General 

� Transports 

� Settings 

� Statistics 

System Logs events by Windows NT 4.0 components, 
including RAS or other WinNT services.

Security Logs security events, such as logons, logoffs, 
illegal access, and so on. This option is available
only to users with Administrative access.

Applications Logs events by application, such as database fil
errors, and so on.

Select To display details about
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Invoking the chkdsk utility

Introduction

The chkdsk utility checks a specified disk on the server and displays a statu
report. Use this utility on drive C or D.

Note: A version of this utility, called autocheck, automatically runs at Window
NT boot-time. Output from this utility appears on the start-up blue screen.

Chkdsk utility syntax

The chkdsk utility uses the following syntax:

chkdsk [drive:][path]filename] [/F] [/V] [/R]

To run the chkdsk utility from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type chkdsk <drive letter:>  (for example, chkdsk 
c:).

Parameters Description

[drive:] The drive letter of the drive you want to check.

filename The names of files to check for fragmentation.

/F Add this switch to fix errors on the disk.

/V Add this switch to display the full pathname of 
every file on the disk.

/R Add this switch to locate bad sectors and to 
recover readable information.
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3 Press Enter.

Result: The system runs the chkdsk utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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Invoking and interpreting TCP/IP diagnostics

Introduction

This section outlines the following TCP/IP diagnostic tools available for the 
Ethernet card. The first three tools are the most useful:

� ipconfig

� ping

� tracert

� arp

� nbtstat

� netstat

The ipconfig command

The ipconfig command displays IP configuration information. 

Ipconfig default
Running the command without flags displays the IP address, subnet mask,
default gateway for each adapter bound to TCP/IP.

Ipconfig command syntax
ipconfig /[]

The following flags are available for the ipconfig command:

Flag Description

/? Displays Help information.

/all Displays full configuration information.

/release Releases the IP address for the specified 
adapter.
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To run the ipconfig command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type ipconfig <with appropriate parameters:>  
(for example, ipconfig /all).

3 Press Enter.

Result: The system runs the ipconfig utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

/renew Renews the IP address for the specified 
adapter.

Flag Description
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The ping command

The ping command sends an echo request to a specified host.

Ping command syntax
The ping command uses the following syntax:

ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS]

        [-r count] [-s count] [[-j host-list] | [-k host-list]]

        [-w timeout] destination-list

Parameters Description

-t Pings the specified host until interrupted.

-a Resolves addresses to host names.

-n count Specifies the number of echo requests to send.

-l size Sends buffer size.

-f Set Don’t Fragment flag in packet.

-i TTL Time To Live.

-v TOS Type Of Service.

-r count Record route for count hops.

-s count Time stamp for count hops.

-j host-list Loose source route along host list.

-k host-list Strict source route along host list.

-w timeout Timeout in milliseconds to wait for each reply.
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To run the ping command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type ping <destination IP address:>  (for 
example, ping 47.286.32.0:).

3 Press Enter.

Result: The system indicates a successful ping.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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The tracert command

This utility determines the route taken to a destination.

How tracert works
The tracert utility follows several steps to complete its task:

� Tracert sends Internet Control Message Protocol (ICMP) echo packets 
varying Time-To-Live (TTL) values to the destination.

� Each router along the path must decrement the TTL on a packet by at 
1 before forwarding it, so the TTL is effectively a hop count. 

� When the TTL on a packet reaches 0, the router sends back an ICMP 
Exceeded message to the source system.

� Tracert determines the route by sending the first echo packet with a TT
1 and incrementing the TTL by 1 on each subsequent transmission unt
target responds, or the maximum TTL is reached. 

� Tracert then examines the ICMP Time Exceeded messages sent back 
intermediate routers.

Tracert syntax
tracert [-d] [-h maximum_hops] [-j host_list] [-w timeout] [target_name]

Tracert parameters
The tracert command uses the following parameters:

Parameter Description

-d Specifies not to resolve addresses to 
hostnames.

-h maximum_hops Specifies the maximum number of hops to 
search for target.

-j host-list Specifies a loose source route along the 
host list.

-w timeout Waits the number of milliseconds 
specified by the timeout for each reply.
Part 5: 1001rp Server Maintenance and Diagnostics 59



Diagnostics  Standard 1.0
To run the tracert command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type

tracert [-d] [-h maximum_hops] [j host_list] [-w timeout] [target name]  

(for example, tracert 47.286.0.32 210 47.236.0.04)

3 Press Enter.

Result: The system runs the tracert utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

target_name The name of the target host.

Parameter Description
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The arp command

The arp command displays and modifies the IP-to-physical address transla
tables used by Address Resolution Protocol (arp).

Arp command syntax
The arp command uses the following syntax:

arp -s inet_addr eth_addr [if_addr]

arp -d inet_addr [if_addr]

arp -a [inet_addr] [-N if_addr] 

Parameter Description

-a Displays current arp entries by interrogating 
the current protocol data. If inet_addr is 
specified, the IP and physical addresses for 
only the specified computer appear. If more 
than one network interface uses arp, entries for 
each arp table appear.

-g Same as -a.

inet_addr Specifies an Internet address.

if_addr Specifies the Internet address of the interface 
whose address translation table should be 
modified. If not present, the first applicable 
interface is used.

eth_addr Specifies a physical address.

-N if_addr Displays the arp entries for the network 
interface specified by if_addr.

-d Deletes the host specified by inet_addr.
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To run the arp command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type arp with the required parameters (for 
example, arp -g 47.286.0.32).

3 Press Enter.

Result: The system runs the arp command.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

-s Adds the host and associates the Internet 
address inet_addr with the Physical address 
eth_addr. The physical address is given as six 
hexadecimal bytes separated by hyphens. The 
entry is permanent.
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The nbtstat command

The nbtstat command displays protocol statistics and current TCP/IP 
connections using NBT. This command is available only if the TCP/IP proto
is installed.

Nbtstat command syntax
The nbtstat command uses the following syntax:

nbtstat [-a remotename] [-A IP address] [-c] [-n] [-R] [-S] [-s] [interval]

Parameter Description

-a remotename Lists the remote computer’s name table using 
its name.

-A IP address Lists the remote computer’s name table using 
its IP address.

-c Lists the contents of the NetBIOS name cache 
giving the IP address of each name.

-n Lists local NetBIOS names. Registered 
indicates that the name is registered by 
broadcast (Bnode) or WINS (other node 
types).

-R Reloads the LMHOSTS file after purging all 
names from the NetBIOS name cache.

-r Lists name resolution statistics for Windows 
networking name resolution. On a Windows 
NT computer configured to use WINS, this 
option returns the number of names resolved 
and registered through broadcast or through 
WINS.

-S Displays both client and server sessions, 
listing the remote hosts by IP address only.
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To run the nbtstat command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type nbtstat with the required parameters.

3 Press Enter.

Result: The system runs the nbtstat utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

-s Displays both client and server sessions, and 
attempts to convert the remote host IP address 
to a name using the HOSTS file.

interval Displays selected statistics, pausing interval 
seconds between each display. Press CTRL+C 
to stop displaying statistics. Without this 
parameter, nbtstat prints the current 
configuration information once.
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The netstat command

The netstat command displays current TCP/IP network connections and pro
statistics.

Netstat command syntax
The netstat command uses the following syntax:

netstat [-a] [-e] [-n] [-s] [-p proto] [-r] [interval]

To run the netstat command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type netstat with the required parameters.

3 Press Enter.

Result: The system runs the netstat utility.

Parameter Description

-a Displays all connections and listening ports.

-e Displays Ethernet statistics. This can be 
combined with the -s option.

-n Displays addresses and port numbers in 
numerical form.

-s Displays per-protocol statistics. 

-p proto Shows connections for the protocol specified 
by proto. Proto can be tcp or udp. If used with 
the -s option, proto can be tcp, udp, or ip.

-r Displays the contents of the routing table.

interval Redisplays selected statistics, pausing 
between each display. Press CTRL+C to stop 
redisplaying.
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4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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Invoking and interpreting Token Ring card 
diagnostics

Introduction

If TCP/IP protocol is installed, you can diagnose faults on the Token Ring c
by using the ping command under Windows NT.

Using the ping command

Instructions for using the ping command are in the procedure “To run the ping 
command from Windows NT 4.0” on page 58.
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Section D: Invoking and interpreting 
serial port diagnostics

In this section
 Overview 70

 Shutting down services 71

 Conducting TSTSERIO tests 73

 Conducting TSTSERIO tests with the loopback plug 77

 Restarting services 78
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Overview

Introduction

Run serial port diagnostics on the 1001rp server using the TSTSERIO 
command. Direct the TSTSERIO command to serial ports on the server aft
services on these ports have been shut down manually.
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Shutting down services

Introduction

Use the instructions in this section to shut down the services that are using
serial port you want to test before you begin the TSTSERIO local loopback t

Services to stop for COM 1 testing
� Remote Access Server

Services to stop for COM 2 testing
� CallPilot SLEE

� MAS EMCI

� MAS Notification Service

� Remote Access Server

Net Stop command

Use the Net Stop command to stop a specified service on a serial port.

. 

CAUTION

Risk of communications loss
By stopping the services on COM 1 or COM 2, you lose th
support access feature.

. 

CAUTION

Risk of stopping call processing
By stopping the services on COM 2, you stop call 
processing on CallPilot.
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NET STOP command syntax
The Net Stop command uses the following syntax:

net stop “[service-name]” 

To invoke the Net Stop command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type net stop “[service name]” . For example, type 
net stop “Remote Access Server.”

3 Press Enter.

Result: The system runs the net stop command utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

ATTENTION
You must restart the services that you shut down throu
the Net Start command after running the diagnostic. F
details, see “Restarting services” on page 78.
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Conducting TSTSERIO tests

Introduction

The TSTSERIO command performs local loopback tests of the serial 
communications ports from the 1001rp server run-time environment.

Note: Before conducting these tests, shut down services using the NET ST
command detailed on page 71.

TSTSERIO command syntax

The syntax for the TSTSERIO command is as follows:

TSTSERIO [/?] /P:comport [/S:subtstname [/L:loops]

. 

CAUTION

Risk of communications loss
By stopping the services on COM 1 or COM 2, you lose th
support access feature.

. 

CAUTION

Risk of stopping call processing
By stopping the services on COM 2, you stop call 
processing on CallPilot.

Flag Requirement Description

[?] n/a Displays Help.

/P:comport Required Specifies the symbolic port 
name assigned to the port you 
want to test.
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TSTSERIO internal loopback diagnostic subtests

The following internal loopback subtests are available for the TSTSERIO 
command. For each of these tests, the communications resource must be 
available:

[/
S:subtstname]

Optional Specifies a TSTSERIO 
subtest. See the table on 
below for a description of the 
available subtests.

[/L:loops] Optional Specifies the number of times 
(up to a maximum of 65 535) 
to execute the requested test. 
The default number of tests is 
1. A value of 0 infinitely 
loops until you enter 
CTRL+C.

Subtest 
name Description

idata Internal data bus loopback

imsr Internal modem status register

baud Internal data bus loopback at various baud 
rates

word Test 5-, 6-, 7-, and 8-bit data lengths

stop Test 1, 1.5, and 2 stop bits

pari Test odd/even parity

fifo Test that device can operate in fifo mode

Flag Requirement Description
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To invoke the TSTSERIO /P command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type tstserio with the required parameters. For 
example, type TSTSERIO /P com1  or TSTSERIO /P com 2 .

3 Press Enter.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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TSTSERIO external loopback plug subtests

The following external loopback subtests are available for the TSTSERIO 
command. For each of these tests, an external loopback connector must be
For more information, see “Conducting TSTSERIO tests with the loopback 
plug” on page 77.

To invoke the TSTSERIO /S command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type tstserio with the required parameters. For 
example, type TSTSERIO /P com1 /S extr . 

3 Press Enter.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

Subtest 
name Description

edata External data bus loopback. This test requires 
an external loopback connector.

emsr External modem status register. This test 
requires an external loopback connector.

eint Test ability of device to generate interrupts. 
This test requires an external loopback 
connector.
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Conducting TSTSERIO tests with the loopback 
plug

Introduction

The TSTSERIO command requires an external loopback connector plug fo
edata, emsr, and eint subtests.

9-pin connector plug

The standard serial loopback connector is a female 9-pin D-sub connector.
connector has the following pins wired together:

� CTS (pin 8) wired to (pin 7) RTS

� SIN (pin 2) wired to (pin 3) SOUT

� DTR (pin 4) wired to (pin 6) DSR

Once the plug is installed on the serial port, TSTSERIO can be invoked 
according to the procedure outlined in the previous section.
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Restarting services

Introduction

This section details how to restart the services for COM 1 or COM 2 after 
invoking the TSTSERIO local loopback tests.

Services to restart after COM 1 testing
� Remote Access Server

Services to restart after COM 2 testing
� CallPilot SLEE

� MAS EMCI

� MAS Notification Service

� Remote Access Server

Net Start command

Use the NET START command to restart a specified service on a serial por

NET START command syntax
The NET START command uses this syntax; net start “[service-name]”

To invoke the Net Start command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type net start “[service name]”. For example, type 
net start “Remote Access Server”. 

3 Press Enter.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.
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Using the Administrative PC to 
diagnose the server

In this chapter
 Overview 80

Section A: Detecting, isolating, and fixing hardware problems 81

 Overview 82

 Detecting hardware problems 83

 Viewing events and isolating problems 84

 Checking channel status 87

Section B: Working with the Maintenance window 91

 Overview 92

 Introducing the Maintenance window 93

 Obtaining general information about components 101

 Viewing component states 103

 Starting and stopping components 106

 Running integrated diagnostics 110

 Viewing last diagnostic results 113

 Obtaining replacement part numbers 116
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Overview

Introduction

This chapter provides information on how to detect, isolate, and fix hardwar
problems on the CallPilot server using the CallPilot Administration Client 
software on the administrative PC.

� The section “Detecting, isolating, and fixing hardware problems” on page 
81 provides details on how to detect, isolate, and fix hardware problem

� The section “Working with the Maintenance window” on page 91 describes 
how to use the Maintenance window as you detect, isolate, and fix 
hardware problems.

Note: The components in the Maintenance window vary based on the type 
switch connected to CallPilot and the server type. The dialog box examples
this chapter are for illustration purposes and might not appear exactly the s
on your system.
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Section A: Detecting, isolating, and 
fixing hardware problems

In this section
 Overview 82

 Detecting hardware problems 83

 Viewing events and isolating problems 84

 Checking channel status 87
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Overview

Introduction

This section provides guidelines on how to detect, isolate, and fix potential 
real hardware problems. 

� “Detecting hardware problems” on page 83 provides information on the 
different ways in which you typically become aware of hardware proble

� “Viewing events and isolating problems” on page 84 describes how to work 
with the Alarm Monitor, Event Browser and Maintenance screen. These
tools are used to isolate the cause of problems and plan a strategy to f
hardware problems.

� “Checking channel status” on page 87 describes how to view channel statu
in the Channel Monitor and Multimedia Monitor.

Component dependencies

The status of some components depend on the operational status of other 
components. If a component fails or is stopped, the dependent components
out of service. 

Note: Based on the type of switch connected to CallPilot and the server typ
some of these components might not appear on your system. 

Component Dependent components 

SCbus all MPBs, MPCs, and all Multimedia and Call channe

Master Timeswitch all MPBs, MPCs, and all Multimedia and Call channe

Timeswitch all Multimedia and Call channels connected to the sa
MPB as the timeswitch

MPC all multimedia channels on the MPC-8 card

DS30x all Call channels associated with that DS30x link cabl
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Detecting hardware problems

Introduction

Typically, you first become aware of a hardware problem when an alarm is 
raised. All hardware faults produce an alarm (or series of alarms, dependin
the problem) in the Alarm Monitor. 

Note: By default, the Alarm Monitor appears on the screen as soon as an a
is raised. It does not appear if Alerting Off has been set in the CallPilot syst
window. For more information on setting or resetting the alerting feature, re
to the Monitoring and Security for the Administrator guide.

Other indications of a hardware problem

Other indications of a hardware problem include the following:

� user complaints

� call processing difficulties, such as busy signals, static, dropped calls, 
trouble connecting, and cross talk (hearing other conversations)

� system administrator log on difficulties

� alert icons on the Maintenance window
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Viewing events and isolating problems

Introduction

Use one of the following methods to isolate and plan a strategy to fix a hard
problem:

� Go to the Alarm Monitor to investigate one or more raised alarms.

� Use the Event Browser to investigate a series of events that occurred ar
the time an alarm was raised.

� Go to the Maintenance window to get status information for any suspec
components. For some components, you can use the Diagnostic tab o
Maintenance window to run a diagnostic test.

Note: For detailed information on how to use the Alarm Monitor and Event 
Browser (for example, how to set preferences), refer to the Monitoring and 
Security for the Administrator guide.

Using the Alarm Monitor

Each alarm in the Alarm Monitor has Help text that often provides a solution
the problem. If the solution is not apparent, use the Event Browser or the 
Maintenance screen to further investigate the problem.
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To investigate using the Alarm Monitor

1 If the Alarm Monitor is not already visible, then in the CallPilot system 
window, go to System Administration > Alarms and Events > Alarm Monitor.

2 Double-click the first critical or major alarm.

Result: The Help window appears. 

3 View the description and recovery action.

4 Repeat steps 2 and 3 for a few more alarms.

5 If the solution to the problem is not apparent, obtain the return code of the 
first event and continue the investigation by using the Event Browser (go to 
“Using the Event Browser” on page 85).

Using the Event Browser

The Event Browser lets you view events that have been recorded in the ser
log. The event listing can help you better determine the root cause of the 
problem. Use the Event Browser to view the time the event occurred, the ob
that generated the event, and the cause of the event.
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To investigate using the Event Browser

1 In the CallPilot system window, go to System Administration > Alarms and 
Events > Event Browser.

2 Double-click an event that appears to be related to the problem, or an event 
that occurred near the time the alarm was raised. 

3 View the description and recovery action.

4 Repeat steps 2 and 3 for a few more events.

5 If the solution to the problem is not apparent, contact your distributor.

Using the Maintenance window

If you suspect or discover a problem with an MPC-8 card or the timeswitch,
the Diagnostic tab of the Maintenance window. You can view the results of 
last diagnostic test run against the component. This produces a list of 
components that might be causing the problem. A probability percentage is
listed with each component that reflects how probable it is that replacing the
component will fix the problem. 

For information on using the Maintenance window to view the results of the 
diagnostic test, see “Viewing last diagnostic results” on page 113.

For information on all aspects of the Maintenance window, see Section B: 
“Working with the Maintenance window,” on page 91.
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Checking channel status

Introduction

The Channel Monitor shows the status of call channels (the connection betw
the server and the switch that carries the call signal to CallPilot). 

The Multimedia Monitor shows the status of multimedia channels (the DSP
ports that process the call— these are the voice, fax, and speech recognitio
channels). 

The Channel Monitor and Multimedia Monitor also enable you to start, stop
courtesy stop channels. To run diagnostics on a channel, use the Maintena
window.

Note: For detailed information on how to use the Channel Monitor and 
Multimedia Monitor, refer to the online Help in the CallPilot system window, 
refer to the Monitoring and Security for the Administrator guide.
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To view call channel states

1 In the CallPilot system window, go to System Administration > Maintenance 
Administration > Channel Monitor.

2 Double-click Channel Monitor.

Result: The Channel Monitor window appears, showing the state of all call 
channels on the system. For an explanation of the channel states, refer to 
the online Help. 
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To view multimedia channels

1 In the CallPilot system window, go to System Administration > Maintenance 
Administration > Multimedia Monitor.

2 Double-click Multimedia Monitor.

Result: The Multimedia Monitor window appears, showing the state of all 
multimedia channels. For an explanation of the channel states, refer to the 
online Help. 
Part 5: 1001rp Server Maintenance and Diagnostics 89



Using the Administrative PC to diagnose the server  Standard 1.0
90 CallPilot



May 2000 Using the Administrative PC to diagnose the server 
Section B: Working with the 
Maintenance window

In this section
 Overview 92

 Introducing the Maintenance window 93

 Obtaining general information about components 101

 Viewing component states 103

 Starting and stopping components 106

 Running integrated diagnostics 110

 Viewing last diagnostic results 113

 Obtaining replacement part numbers 116
Part 5: 1001rp Server Maintenance and Diagnostics 91



Using the Administrative PC to diagnose the server  Standard 1.0
Overview

Introduction

Use the Maintenance window to do the following:

� Obtain general information about components.

� View component states.

� Start and stop components.

� Run integrated diagnostic tests.

� View the results of the last diagnostic test run against a component.
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Introducing the Maintenance window

Introduction

All physical and logical hardware components are listed in the Maintenance
window tree. This tree shows how components relate to each other. For exa
eight multimedia channels exist as subcomponents for each MPC-8 card.

When you select a component in the Maintenance window, at least one of t
following tabs appear:
. 

Note: The components in the Maintenance window vary based on the type 
switch connected to CallPilot and the server type. The dialog box examples
this chapter are for illustration purposes and might not appear exactly the s
on your system.

Tab Description

General This page shows general technical 
information about the selected 
component. 

Maintenance This page shows the state of the selected 
component. You can also take some 
components out of service from this page. 

Diagnostics This page enables you to run component-
specific diagnostics.

Replacement This page shows replacement part 
numbers for selected components. This 
option is not available for all platforms. 
Contact your distributor for latest part 
number information.
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The General tab

Use the General tab to view general information about components.

 

Box Description

Attribute Shows component-specific general technical information

Value Shows additional details, such as the speed of a selecte
device.
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The Maintenance tab

Use the Maintenance tab to view the state of the highlighted component an
start and stop a component before running a diagnostic test.
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Box Description

State Specifies the state of the highlighted component.

Administrative This is a Desktop Management Interface (DMI) summar
state. You do not need this state.

Availability This is a DMI summary state. You do not need this state

Operational This is a DMI summary state. You do not need this state

Usage This is a DMI summary state. You do not need this state

Stop Use this button to take the selected device out of servic
immediately. All calls in progress are disconnected.

Caution:
For CallPilot servers connected to a Lucent, Mitel, or 
Rolm switch, if you stop an individual call channel, the 
corresponding port on the switch side is not automatica
disabled. As a result, calls can continue to land on the 
stopped channel resulting in a Ring-No-Answer.

If you need to stop an individual channel, you have two 
options:

� Busy-out the port on the switch side. This must be do
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the
call channel or courtesy stop all call channels in the 
system.

This caution does not apply to stopping DSP ports.
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Courtesy stop Use this button to take the selected device out of servic
after all calls are finished. This prevents any calls from 
being disconnected.

Caution:
For CallPilot servers connected to a Lucent, Mitel, or 
Rolm switch, if you stop an individual call channel, the 
corresponding port on the switch side is not automatica
disabled. As a result, calls can continue to land on the 
stopped channel resulting in a Ring-No-Answer.

If you need to stop an individual channel, you have two 
options:

� Busy-out the port on the switch side. This must be do
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the
call channel or courtesy stop all call channels in the 
system.

This caution does not apply to stopping DSP ports.

Start ��� ���� �	��
� �
 �	� ��� ��
����� ������ �� �������.

Power Up Use this button to power up an MPC-8 card that had be
powered down. You can only use this button for MPC-8 
cards on a 200i server. 

Power Down Use this button to power off an MPC-8 card prior to 
replacing it. You can only use this button for MPC-8 card
on a 200i server. 

Box Description
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The Diagnostics tab

Use the Diagnostics tab to run a diagnostic test or to view the results of the
diagnostic test run on a component.

Box Description

List of Diagnostics for 
Selected Device

Shows the diagnostic tests that are available for the 
highlighted component.

Run Use this button to run the selected diagnostics. For the 
Timeswitch and MPC components, go to the Maintenan
tab to courtesy stop the component before you run 
diagnostics.

Stop Use this button to stop the selected diagnostics
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Last Result Use this button to view the results of the last diagnostic 
test.

The results include a list of Field Replaceable Units 
(FRU), which, if replaced, might fix the problem. Each 
FRU is shown with a percentage that shows how probab
it is that the component caused the hardware problem.

Description Shows a comment or description for a selected diagnos
test.

Instructions Shows the instructions for the user to run the diagnostic
test.

Box Description
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The Replacement tab

The Replacement tab shows component part number information. This tab i
available for all platforms. To be certain you have the latest component 
information, contact your distributor.

Box Description

Description Shows the name of the highlighted component.

Manufacturer Shows the manufacturer of the component.

Model Revision Shows the revision number for the component.

���� ���	
r Shows the part number for the component.

Technical Support URL Shows a web site address where you can get technical 
support.
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Obtaining general information about 
components

Introduction

Find general technical information for each hardware component listed in th
tree using the General tab of the Maintenance window.

For a description of the General tab, see “The General tab” on page 94.

Type of technical information

Technical information about hardware components typically includes details
such as the following:

� the name, class, type, series, or version of a component

� various capabilities of a component (for example, the speed of a CPU)

� the available disk space
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Getting there   CallPilot system > System Administration > Maintenance 
Administration > Maintenance

To view component details

1 From the left pane of the Maintenance window, select the hardware 
component about which you want to obtain information.

Result: The General page appears with general information shown.
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Viewing component states

Introduction

View a component’s state to determine the general condition of the compon
including whether the component is disabled or off duty. You can view the s
of components that are listed in the Maintenance tab of the Maintenance 
window.

For a description of the Maintenance tab, see “The Maintenance tab” on page 
95.

Component states

The state of a hardware component changes depending on the following fa

� whether the component is currently involved in processing a call

� whether a diagnostic test is being run on the component 

� whether the component is out of service 

You can determine the state of a component by looking at the State field in 
Maintenance tab. 

State Description

Active The component is working and currently involved in 
processing a call. 

Idle The component is working but not currently involved in 
processing a call.

Uninstalled The component is not installed or properly configured. Th
usually happens only when the system is being configure
or if the database is corrupted.

Shutting Down The component is in the process of stopping. 

This state occurs quickly and is immediately followed by O
Duty.
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Details 
These states (Administrative, Availability, Operational, and Usage) are stan
Desktop Management Interface (DMI) states. They are shown for administra
who understand and use the DMI standard in other aspects of their jobs. Yo
not need to use the DMI states; the summary state listed in the State field i
provided instead. 

Alert icons
If one of the following icons appears next to a component in the tree, the 
component or one of its subcomponents is experiencing a problem:

Loading The component has been started, which takes it out of th
Off Duty state. 

This state occurs quickly and is immediately followed by 
Idle.

No resources The hardware required for the component to operate is 
installed or not operating properly. 

Off duty The component has been stopped.

Remote Off Duty The component has been taken out of service at the swi

Icon Description

 This means that a diagnostic test run on the component has fa
and the component has been placed into disabled status. 

You must view the last results of the diagnostic test. See 
“Viewing last diagnostic results” on page 113.

This means that a problem exists with one of the component’s
subcomponents. 

Expand the tree to locate the subcomponent with the problem

State Description
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Getting there  CallPilot system > System Administration > Maintenance Administration 
> Maintenance

To view the state of a hardware component 

1 From the left pane of the Maintenance window, select the hardware 
component. 

Result: The General page appears.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

3 View the state of the selected component in the State field.
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Starting and stopping components

Introduction

When you stop a component, it goes out of service and stops operating. Yo
must either stop or courtesy stop a component before you can run a diagno
test on it. 

When you start a channel, it goes back into service. You must start a chann
after replacing it, or after running a successful diagnostic test, to bring it ba
into service.

Courtesy stop 
A courtesy stop takes the component out of service only after the componen
finished processing the active call. If the component is currently processing
call, the call is not dropped. If the component is not currently in use, it is tak
out of service immediately. This method is preferred over a regular stop.

Stop
A stop takes the component out of service immediately, regardless of wheth
the component is currently processing calls. All active calls are dropped. 
Typically, you perform a stop only when severe problems occur that are 
affecting a large number of incoming calls, or if your organization determine
special need for it.

ATTENTION  Nortel Networks recommends that you courtesy stop a 
component if possible. 

In the Maintenance window, the courtesy stop option is 
available only at the individual channel level. 

To courtesy down CallPilot, use the Multimedia Monitor to 
courtesy stop all DSPs. 

To courtesy stop a range of multimedia channels or all 
multimedia channels on an MPC [DSP] card, use the 
Multimedia Monitor. See “Checking channel status” on page 
87 for an overview of the Channel Monitor and Multimedia 
Monitor.
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Components that can be started and stopped

This section lists components that can be started and stopped.

If you want to start or stop more than one or two multimedia or call channel
use the Channels windows. See “Checking channel status” on page 87 for an 
overview of the Channel Monitor and Multimedia Monitor. For detailed 
information, refer to the Monitoring and Security for the Administrator guide.

Note: Based on the type of switch connected to CallPilot and the server typ
some of these components do not appear or do not have the Stop option: 

. 

CAUTION

Risk of Ring No Answer on disabled (stopped) call channel on 
Lucent, Mitel, or Rolm systems
For CallPilot servers connected to a Lucent, Mitel, or Rolm 
switch, if you stop an individual call channel, the corresponding
port on the switch side is not automatically disabled. As a resul
calls can continue to land on the stopped channel resulting in a
Ring-No-Answer.

If you need to stop an individual channel, you have two options

� Busy-out the port on the switch side. This must be done 
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the call 
channel or courtesy stop all call channels in the system.

This caution does not apply to stopping DSP ports.

Component Effect of stopping

SCbus takes out of service all call processing 
resources

Timeswitch takes out of service the MPB16 card that is 
serviced by the timeswitch
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MPC-8 cards takes out of service the selected MPC-8 
card

Multimedia (DSP) 
channels

takes out of service the selected DSP 
channel

Switch Interface Link 
(found under the Switch 
Interface Card 
component)

takes out of service the selected link to the 
switch

Call channels takes out of service the selected call channel

DS30x link takes out of service the selected DS30x link

Component Effect of stopping
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Getting there  CallPilot system > System Administration > Maintenance Administration 
> Maintenance

To start or stop a component in the Maintenance window

1 From the left pane of the Maintenance window, select the hardware 
component you want to start or stop. 

Result: The General page appears.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears. 

3 Click Start, Courtesy Stop, or Stop. 
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Running integrated diagnostics

Introduction

You should run diagnostic tests from the Diagnostic tab in the Maintenance
window in the following circumstances: 

� After installing or reinstalling a component, make sure it is operating 
properly. (A component must be Off Duty [stopped] before you can run 
diagnostic test. See “Starting and stopping components” on page 106.)

� Run the tests if the CallPilot server experiences trouble processing 
incoming calls. Problems include static, dropped calls, and cross talk 
(hearing another conversation).

Note: For a description of the Diagnostic tab, see “The Diagnostics tab” on page 
98.

List of components that have diagnostic tests available
� MPC (DSPs)

� Timeswitch (depending on the switch type, diagnostics might not be 
available)

To view available diagnostic tests

The available diagnostic tests for each component appear in the Diagnostic
of the Maintenance window. Click a component to see the diagnostic tests 
available for that component. 

If a diagnostic test fails or cannot be run

If a warning box appears, the diagnostic test cannot be run because a prere
condition has not been met. If a diagnostic test fails, the failure is indicated a
bottom of the Diagnostic tab. 
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In both cases, check the Alarm Monitor to determine the reason and the 
appropriate action to take. (See “Detecting, isolating, and fixing hardware 
problems” on page 81.)

To run a diagnostic test

Note: See “Starting and stopping components” on page 106 for details about 
courtesy stopping a component. Nortel Networks recommends that you cou
stop rather than stop a component if possible.

1 From the left pane of the Maintenance window, select the hardware 
component for which you want to run a diagnostic test.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

3 Stop the component.

4 From the right pane, click the Diagnostic tab.

Result: The Diagnostic page appears. 
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5 Select the diagnostic test you want to run.

6 Click Run.

7 View the diagnostic test results at the bottom of the Diagnostic page. 
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Viewing last diagnostic results

Introduction

If the Alarm Monitor and Event Browser do not provide a solution to a hardw
problem, a component might need to be replaced or serviced. If the problem
rests with a component that is not replaceable because it is not a physical e
(such as the timeswitch), you must replace its parent component or contact
technical support, depending on the component.

Replaceable parts are called Field Replaceable Units (FRUs). View the last
diagnostic test result in the Diagnostic tab of the Maintenance window to ob
a list of FRUs that, when replaced, will likely fix the problem.

Notes: 

1. For general information on investigating hardware problems, see 
“Detecting, isolating, and fixing hardware problems” on page 81.

2. For a description of the Diagnostic tab, see “The Diagnostics tab” on page 
98.

Field replaceable units

When you view the last results of a failed diagnostic test, a Diagnostic Resu
description appears at the bottom of the Diagnostic tab. This description 
includes a list of components that might have caused the problem. 

Each FRU is shown with a percentage that represents how probable it is th
component caused the hardware problem. Use these percentages as a gui
determine which component to try replacing first; the higher the percentage
probability, the better the chance that replacing the FRU will fix the problem
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To view the last diagnostics result 

1 From the left pane of the Maintenance window, select the hardware 
component. 

Result: The General page appears.

2 From the right pane, click the Diagnostics tab.

Result: The Diagnostics page appears.

3 Click Last Result.

Result: The results of the last diagnostic test appear at the bottom of the 
Diagnostics page.

4 View the last results to determine what action to take.
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Last diagnostic results

The results of the last diagnostic test display the following information at the
bottom of the Diagnostic page: 

Information Description

Target Object This is the component selected in the tree.

Diag ID This is the ID of the diagnostic test that was run. 
The diagnostics IDs and descriptions are listed in 
the List of Diagnostics for Selected Device 
window on the Diagnostics page.

Diag result The diagnostic result includes a return code and 
whether the diagnostic test passed or failed. 

Result Description This section appears only when the diagnostic te
fails. This is a more detailed description of the 
problem. This description includes the following:

� the error that was encountered

� a list of components that might have caused 
the error with a probability percentage

� troubleshooting instructions
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Obtaining replacement part numbers

Introduction

If you determine that a component needs to be replaced, contact your distrib

The Replacement tab in the Maintenance window provides component 
information. However, your distributor has the latest part number informatio
The Replacement tab is not available on all platforms.
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System utilities

In this chapter 
 Overview 118

 Diagnostics 119

 PEP Maintenance utility 122

 Services Monitor 124

 Session Trace 126

 System Information 134

 System Monitor 136

 VoiceBridge Monitor 139
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Overview

Introduction

The following table lists the CallPilot system utilities:

Accessing the System Utilities

All CallPilot customer administrator tools are accessible from the server usi
Start > Programs > CallPilot > System Utilities.

Diagnostic Enables CallPilot startup diagnostics to be 
enabled or disabled (turned on or off).

PEP Maintenance Displays a list of installed PEPs and enables PEP
uninstall.

Services Monitor Displays the true status of all CallPilot services 
according to WinNT definition.

Session Trace Provides detailed information about the activity 
in a user’s mailbox and the state of the message 
waiting indicator (MWI).

System Information Displays particulars about the CallPilot System 
such as names, keycodes, serial numbers, IP 
addresses, and system numbers.

System Monitor Displays the status of all CallPilot subsystems 
related to call processing.

VoiceBridge Monitor Troubleshooting tool that provides phone 
simulation for the DSE connectivity.
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Diagnostics

Introduction

The Diagnostics startup utility is a graphical user interface that enables Call
startup diagnostics to be enabled or disabled as required by the user or the
system.

CallPilot startup diagnostics automatically identifies hardware problems tha
might exist when the system and its services are started (DSP, TimeSwitch
SCbus).

This tool saves time during system maintenance operations where restarts 
Call Processing services restarts are required.

There are three recommended steps:

� Use the Diagnostics tool to turn off CallPilot startup diagnostics.

� Perform system maintenance.

� Use the Diagnostics tool to turn on CallPilot startup diagnostics.
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To access the startup Diagnostic Tool utility

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Diagnostic Tool.

Result: The Diagnostics Tool window appears.
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To enable startup diagnostics

From the menu, select Configuration > EMCI Startup Diag > Enable.

To disable startup diagnostics

From the menu, select Configuration > EMCI Startup Diag > Disable.

Note: Nortel Networks recommends that you leave the startup diagnostics 
turned on.

When you disable CallPilot startup diagnostics; you prevent CallPilot from 
automatically identifying hardware problems that might exist when the syste
and its services are started (DSP, TimeSwitch, SCbus).
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PEP Maintenance utility

Introduction

The PEP Maintenance utility displays a list of all installed PEPs on the serv
and enables you to uninstall PEPS.

For information on uninstalling PEPs, refer to “Installing PEPs” on page 338

To access the PEP Maintenance utility

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
PEP Maintenance. 

The DMI Viewer window appears.
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To view a list of all installed PEPs

1 Click the component to display the PEP list.

2 Click Show PEPs.

Result: A list of all installed PEPs appears to the right of the window.
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Services Monitor

Introduction

The Services Monitor is a graphical user interface tool that helps to determ
whether the CallPilot server is fully operational. It displays true states of the
CallPilot services according to Windows NT definition, including the states t
are not available through the control panel.

To access the Services Monitor

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Service Monitor.

Result: The ServiceMon window appears.
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Using the Services Monitor

The Services Monitor provides the status of each CallPilot service (for exam
running, any pending or pausing state).

The Refresh All button enables the display to be refreshed. Use the Set Re
Rate button to set the rate of refresh or set to none.

Note: The fact that a service is running does not necessarily mean that it is 
operational. It might require some initialization, database connections, inter
data structures, and so on.
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Session Trace

Introduction

The Session Trace tool allows you to obtain detailed information about the 
activity in a user’s mailbox and the state of the message waiting indicator 
(MWI). The session information includes

� voice messaging

� call answering

� express messaging activity (messages composed and sent, or left in a
mailbox)

� the number of messages played or unplayed at the beginning, middle, 
end of a session

� messages and personal distribution lists restored into a mailbox

� the last change to the MWI (turned on or off, or untouched)

This session information allows an administrator or technician to study the s
of a user’s mailbox and the MWI, and to use that information to follow up on
any user complaints. For example, a user might complain that the MWI was
but no voice messages were in the mailbox when the user logged on. The se
information might tell the administrator why the MWI was turned on.

To access the session trace tool

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Session Trace Tool. 

Result: The MCE Session Trace window appears.
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To find a session

1 From the Session Type drop-down menu, select the type of session.

To display a list of all session types, select All Session Types.

2 Enter as much information in the search criteria fields in the window to 
identify the session you want to view.

To display a list of all users for the selected Session Type, leave the search 
criteria fields blank.

3 Click Search to initiate the search. 

a. If you did not enter any user information, a list of users matching the 
Session Type appears on the bottom of the window.

To select a user from the list, double-click the user name to display 
session type information.

b. If you selected All Session Types for a user, the session type 
information appears to the right of the window. 

4 Double-click the session type to display the session information.

Result: The Session Type information appears on the bottom of the 
window.
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Session type information

Call Answer session type information
Part 5: 1001rp Server Maintenance and Diagnostics 129



System utilities  Standard 1.0
Expired messages session type information
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Express messaging session type information
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Logon session type information
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Selective restore session type information
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System Information

Introduction

Use this utility to view particulars about the CallPilot system, such as name
keycodes, serial numbers, IP addresses, and system numbers.

To access the System Information utility

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
System Information.

Result: The CallPilot System Information window appears.
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To use the System Information utility

Use this utility to view CallPilot system information at a glance.

After viewing the information on this screen, click Close to close the window
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System Monitor

Introduction

The System Monitor is a graphical user interface based tool that provides a
single point of view of CallPilot call processing status at any time. The statu
provided reflects the true internal status of the Call Processing subsystem, 
including all related call processing components. This eliminates the need to
multiple tools to get the same information.

The System Monitor queries the current status of each component it is 
monitoring and displays them in a graphical user interface. The status of ea
service is obtained from the Windows NT Service Controller; Middleware 
Components status are obtained from the CT Media server; and the DSP a
Call channels status are obtained by querying Middleware. 

This tool shows the status of

� CallPilot Critical Services related to call processing

� CT Media-based Middleware Services

� CallPilot Call Channels and Media Channels

System Monitor is a nondestructive tool that does not alter the behavior of a
CallPilot components.

Note: Users of this tool require an understanding of CallPilot and the 
components they want to monitor.
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To access the System Monitor

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
System Monitor.

Result: The CallPilot System Monitor window appears.

User interface

The user interface comprises four main areas listed below. Each area indic
the status of the particular components of the CallPilot server.

1. Services Area for Critical Windows NT-based services

2. CT Media Services Area for Middleware-based services

3. Call Channel Area for Call Arrival/Departure activities

4. Media Channel Area for DSP channel usage activities

CallPilot Critical Services
�������
 �������� ������ �
� ��

��

� ��

 ��
������� include

� CT Media Server Service

� Telephony Server (TAPI) Service

� MAS EMCI Service
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� MAS Notification Service

� MCE SLEE Service

� MCE Notification Service

� SQL Anywhere Service

� VBPC Load Service (useful in a DSE system)

CT Media-based Middleware Services
����
����� ���
	���� ������ �
� ��

��

� include

� Dialogic CT Media Server Core Service

� Dialogic CT Media Server ISE Service

� Call Channel Resource Service

� Blue Call Router Service

� Media Resource Service

� Maintenance Service Provider Service

CallPilot Call Channels and Media Channels
��

 ��� ����� ������
� ������ �
� ��

��

� include

� �	
������� �
��� ��� ��

 ������
 �DSP channel usage as well as Call 
Channel usage)

Online Help
To obtain a description of the various status codes for each of the window’s
components, use the online Help.

Menu items
The System Monitor tool provides several menu items for configuration:

File Closes the tool.

Refresh rate Changes the refresh rate to a desired level.

Help Displays a legend for each status symbol 
shown.
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VoiceBridge Monitor

Introduction

The VoiceBridge Monitor is a graphical user interface tool that provides help
when the CallPilot DSE system is first configured by simulating a phoneset.

It can also be used to troubleshoot phoneset, line, cable, or switch-related 
problems should they occur.

The simulated phoneset provides the ability to

� answer an incoming call

� make an outbound call

� transfer an incoming call to another extension

� display dialed party extension

� show the carrier presence on the phoneset

� show other characteristics specific to the phoneset being simulated, su
time of day and other features programmed on the phoneset

Note: This tool is for DSE only. Users require an understanding of switches
involved in DSE connectivity.

Installing VoiceBridge Monitor

The VoiceBridge Monitor can be installed from the CallPilot Server PEP CD
For information on installing VoiceBridge Monitor, refer to “Installing softwar
for the Lucent, Mitel, and Rolm switch” on page 348.

It takes approximately three minutes to install this tool and requires a syste
restart.
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To access VoiceBridge Monitor

Click Start > Programs > VoiceBridge 2000 > VoiceBridge Monitor.

Using the VoiceBridge Monitor

Once executed, the VoiceBridge Monitor tool appears.

Menu items
The VoiceBridge Monitor tool includes several menu items for configuration

Use the mode menu to select Active PC Phone mode.

ATTENTION Do not use this tool when CallPilot is in use as it 
can affect CallPilot operation. When this tool is 
connected to an external phoneset, you cannot 
hear on the soft phoneset.

Mode menu Allows for the selection of a different mode of 
operation. Only active mode is used with this tool in 
DSE connectivity.

File menu Allows for the selection of a preferred channel for 
monitoring. Some channels can be opened.
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Note: Nortel Networks recommends that you do not use other modes, as th
require additional hardware components to function. 

Once the Active PC Phone mode is selected, you can open any or all chann
the VoiceBridge boards from the File menu and view them, as shown below

Using soft phones

The soft phone is connected to the VoiceBridge 2000 board installed on the
CallPilot system and can be considered a physical phoneset. Actions that c
done with a soft phone include

� checking if a carrier exists between the phoneset and the switch

� making a call to the physical phoneset and viewing the phoneset or the
that is assigned to this CallPilot port

� making a call from a physical phoneset to this soft phone to check if the
shows up on the soft phone

� making a call from a physical phoneset to this phoneset and transferrin
to another physical phoneset to see if transfer is possible with CallPilot
ports

Soft phone displays
The display of the soft phone varies depending on the switch to which the 
CallPilot server is connected. 
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Rolm phone
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Mitel phone
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Lucent 8400
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Performing hardware maintenance
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Section A: Chassis components

In this section
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About the 1001rp server chassis

Introduction

This section describes procedures for handling and replacing chassis 
components on the 1001rp server.

Replacing components

Procedures covered include the following:

� removing covers

� replacing the air filter

� replacing a power supply module

� replacing a cooling fan

� replacing SCSI hard drives

� replacing the fuse

� replacing the status board

� replacing the panel display
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Removing the chassis cover

Introduction

Access the 7 ISA/1 SBC/12 PCI Slot passive backplane for performing any
maintenance activities by removing the cover.

Requirements

Before removing the cover, gather the following tools:

� flat-blade screwdriver

� antistatic wrist strap

To remove the top cover

1 Power down the server and disconnect all power cords.

2 Loosen the three thumbscrews at the rear of the top cover.

3 Remove the top cover by pulling the cover toward the rear of the chassis, 
and then lifting it up and off.

. 

CAUTION

Risk of equipment damage
Take precautions to protect internal components. 
Electrostatic discharge (ESD) can render boards damag
or unusable. Wear an ESD wrist strap.

. 

DANGER

Risk of electric shock
High current inside the chassis can cause severe injury.
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Removing and replacing the front bezel

Introduction

Two locked doors on the plastic front bezel enable you to access the extern
peripheral bay, SCA disk drives, 3.5-inch floppy drive, and removable coolin
fans. Use the following procedures to remove and replace the front bezel b
replacing other system components.

Doors on the front bezel

Requirements

To remove the front bezel, you require the following tools:

� keys to the front bezel

� antistatic wrist strap
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The front bezel

To remove the bezel

1 Unlock and open the double doors of the front bezel.

2 Firmly grasp the bezel by the hand-holds at either side of the chassis.

3 Pull the bezel from the chassis.

What’s next?

Once the front bezel is removed, you can change the air filters or replace a
swappable cooling fan. The procedures for each of these tasks are located 
section.

. 

CAUTION

Risk of equipment damage
Do not attempt to move or lift the server before removin
the front bezel; the server might disengage from the bez
and fall.
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Ball stud on the faceplate

Groove on the bezel

To replace the bezel

Once you complete maintenance or part replacement activities, to replace t
front bezel, follow these steps.

1 Align the front bezel with the ball studs located at each faceplate corner.

2 Apply pressure evenly until the bezel snaps onto each ball stud.

3 Close the double doors of the front bezel and lock it into place.
154 CallPilot



May 2000 Performing hardware maintenance 

ery 
 and 
ace 

oors 
 of 
Replacing air filters

Introduction

Remove and clean air filters every six months in clean environments and ev
three months in industrial or dirty environments to ensure your server cools
functions properly. If they appear to be damaged or become inefficient, repl
the filters.

Locating the air filters

There are four air filters on the 1001rp server — one inside each of the two d
of the front bezel, and two on the top half of the front bezel. They are made
polyester foam material and are flame retardant.

Requirements

You require the following equipment to replace air filters:

� the customer’s chassis keys

To replace the front bezel air filter

1 Remove the front bezel from the chassis.

2 Pull filters from the Velcro strips securing them to the bezel.

3 Replace the filter by seating new filter pads evenly over the velcro strips 
and securing them.

4 Install and lock the front bezel on the chassis.

See also

To remove the air filter, remove the front bezel. Refer to the procedures for 
“Removing and replacing the front bezel” in this section.
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To replace the door air filter

1 Unlock and open the front doors.

2 The air filter is trapped between the inside of the door and the wire. The 
wire pivots near the key lock. Pull the wire away from the key lock to free the 
air filter.

3 Remove and replace the air filter.

4 Pivot the wire to trap the filter, ensuring that the ends of the wires are 
pinched inside the door.

5 Close and lock the doors.
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Replacing hot-swappable components

Introduction

If your system experiences problems with the cooling fan, hard drives, or th
power supply, replace these parts without shutting down the server. These 
swappable components enable you to leave the server on and operational 
you replace redundant components.

Note: You require a RAID card to replace hard disks without shutting down 
system.

System monitors

The chassis incorporates on-board management features that notify the op
in case of a problem. Power supply, fan, and chassis temperature status ar
constantly monitored. In the event of a failure, an alarm sounds and the 
appropriate LED on the front panel turns on as an indication. The LED on th
failed power supply module turns from green to red.

Hot-swappable components

The following components are easily hot-swapped:

� power supplies

� cooling fans

� SCA SCSI hard drives

Requirements

Before hot-swapping a power supply, cooling fan, or SCSI hard drive, gathe
following tools:

� one flat-blade screwdriver

� one Phillips screwdriver

� one antistatic wrist strap
Part 5: 1001rp Server Maintenance and Diagnostics 157



Performing hardware maintenance  Standard 1.0

n 
 
dule 
� the replacement power supply, if needed

� the replacement cooling fan module(s), if needed

� the replacement hard drive(s), if needed

They can be any one or a combination of the following:

(1) 4 Gbyte SCSI Hard Disk, hot-swappable

(2) 9 Gbyte SCSI Hard Disk, hot-swappable

When to hot-swap the power supply

A green LED indicates that the power supply is working properly. If the gree
LED on the power supply module is unlit or red, the module is failing or has
failed. Other indicators are the alarm that sounds and the power supply mo
LED on status display that turns red.

The power supply

G100867

Power 
switch

Power 
input

Fuse 
receptacle

Hot-swap power
supply modules

Alarm 
board
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To hot-swap a power supply

1 Loosen the thumbscrews at the top right and left of the failed power supply 
module. If needed, use a flat-blade screwdriver. The thumbscrew must 
rotate freely and not contact the chassis threads.

2 Pull the power supply module free from the chassis using the molded 
horizontal handle on the power supply module.

3 Align the replacement module with the empty chassis bay.

4 Slide the replacement power supply module into the bay until the module is 
secured by its connector. Use some force, if necessary.

5 Secure the power supply module to the chassis with two thumbscrews at 
the corners of the power supply faceplate.

Result: The power supply LED illuminates green.

Note: If the LED does not illuminate, remove and reinstall the power supply 
with more force. If this does not work, contact your Nortel Networks 
customer support representative.

. 

DANGER

Risk of electric shock
High current inside the chassis can cause severe injur
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When to hot-swap the fan

When the LED associated with a cooling fan becomes red, the fan requires
replacement.

To hot-swap a cooling fan

1 Remove the front bezel. Use the front panel display LED to locate the 
defective fan.

2 Loosen the thumbscrew located on the outside of the failed cooling fan 
module. If needed, use a flat-blade screwdriver.

3 Unseat the cooling fan module by sliding the module horizontally away from 
the display and toward the rack rail.

Result: The module power connector unseats from the power connector 
located behind the display and LEDs.

4 Slide the failed cooling fan module out of the chassis.

5 Align the replacement cooling fan module tabs with the four support slots 
on the chassis. Be sure the module is oriented with the thumbscrew, and 
insert the tabs into the supporting slots of the chassis.

6 Slide the cooling fan module toward the front panel display and into 
position.

Result: The fan module connects with slight resistance. The fans rotate 
and pull air into the chassis. The cooling fan LED goes out.

7 Tighten the module’s thumbscrew and replace the front bezel.

Status panel

Hot-swap fan modules
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When to hot-swap hard drives

With a RAID controller, hot-swap device drivers, and operating system supp
SCA SCSI hard drives can be hot-swapped on the 1001rp server. Without t
RAID controller, hot-swap device drivers, and operating system support, 
replacing a drive during server operation can cause a fatal error and force a
system restart. If a RAID controller is not installed, shut down the system fir
and then replace drives.

Note: Identify which hard drive to remove using the Windows NT event log.

Removing hard drives

To replace hot-pluggable SCA SCSI hard drives

1 Open the front bezel doors.

2 Locate the SCA SCSI drive frame below a cooling fan and beside the 
media drive.

3 Loosen the two thumbscrews on the hard drive carrier.

4 Remove an existing drive by loosening the four Phillips-head screws that 
secure it to the carrier.

5 Attach the new drive to the carrier by four Phillips-head screws.
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6 Align the carrier with the drive frame and slide it into the chassis. Expect 
resistance as the carrier and backplane connectors meet.

7 Fasten the two thumbscrews.

8 Close the front bezel and lock it into place.

What’s next?

If the drive you replaced was part of a RAID mirrored system pack, run DAC
Administration software under Windows NT to rebuild that drive. If you do n
do this, the system is still prone to data loss if another disk fails.
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Replacing the fuse

Introduction

The fuse is located below the power input socket on the rear panel. When t
server’s fuse blows, the server stops operating. 

Requirements
� an approved fuse for replacement

Two different types of fuses exist for North America and for internationa
use. Ensure that the fuse you are replacing has been approved by Nor
Networks.

� flat blade screwdriver

. 

CAUTION

Risk of equipment damage and personal injury
Disconnect power from the server before replacing a 
fuse.
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AC System only

To replace the fuse

1 Power off the server.

2 Unplug the power cable from the wall outlet.

3 Unplug the power cable from the power input socket on the server.

4 Unscrew the fuse receptacle.

5 Slide the fuse receptacle out of the fuse chamber.

Note: Observe how the blown fuse is positioned in the receptacle.

6 Remove the blown fuse.

7 Install the approved fuse.

8 Slide the fuse receptacle back into its chamber.

9 Fasten the fuse receptacle with a flat-blade screwdriver.

10 Plug the power cable back into the power input socket on the server.

Power 
switch

Power 
input

Fuse 
receptacle
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11 Plug the power cable into the wall outlet.

12 Power on the server.

ATTENTION
If the fuse blows after replacement, swap one power
supply module with the other. If this does not work, 
call your Nortel Networks customer support 
representative.
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Alarm board

Introduction

The 1001rp server alarm board and panel display monitor and indicate the s
status. The confidence test on page 34 fails if the board is defective or damaged
When these units are damaged, replace them immediately. 

Requirements

Before replacing the status board or panel display, gather the following tool

� one Phillips screwdriver

� one antistatic wrist strap

� the replacement component(s)

. 

CAUTION

Risk of equipment damage
Take precautions to protect computer boards. Electrostat
discharge (ESD) can render boards damaged or unusabl
Wear an ESD wrist strap.
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Alarm board location

To replace the status board

1 Power off the server.

2 Loosen the two thumbscrews securing the faceplate at the left of the 
1001rp server power supply modules.

3 Pull the carrier free from the chassis.

4 The status board is secured to the carrier by two Phillips-head screws. 
Remove the defective status board from the carrier.

5 Secure the replacement status board to the carrier using two Phillips-head 
screws.

6 Align the carrier with the chassis and slide the board into the chassis. The 
card encounters some resistance as it meets the connector.

7 Tighten the thumbscrews to secure the faceplate to the chassis.

Alarm 
board
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Jumpers on the alarm board

Introduction

This section describes the features enabled or disabled by setting jumpers 
alarm board.

Jumper block and switch on the alarm board

Setting jumpers on the alarm board

The jumpers on the alarm board enable or disable sensing and display func
The default setting enables the sensing or display. The default setting is wit
jumpers removed. 

JP6 - do not change

Leave the jumper installed.
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Disarming “No Power” in the bottom bay

Jumper block 1, JP5 : Jumper both pins to instruct the alarm board not to re
no power signal coming from the bottom power supply. Jumper both pins w
one power supply is used, and install that supply in the upper power bay. En
that both pins are not jumpered to allow the alarm board to sense power sta
from both upper and lower power supply bays.

JP4

Jumper block 1, JP4 : not used.

Display or No display

Jumper block 1, JP3 : Jumper both pins to configure the alarm board to sen
alarm signals to the full array of LEDs. If this jumper is not installed over bo
pins, the alarm board does not send the correct format of signals to the fron
panel display.
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Status display

Locating the display

The display is located at the front of the chassis and is cabled to the rear of
chassis and the Status Board.

The status panel

To replace the display

1 Power off the server.

2 Remove the top cover and the front bezel from the chassis.

3 Loosen the four Phillips-head screws securing the display to the front of the 
chassis.

4 Disconnect the cable and lift the defective display up and out of the chassis.

5 Set the replacement display into position, and secure it to the chassis by 
replacing the Phillips-head screws.

6 Reconnect the cable.

7 Replace the top cover and front bezel.

Status panel
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Section B: RAID system

In this section
 Overview 172

 RAID system summary 173

 Replacing the RAID card 174

 Attaching cables to the RAID card 176

 Replacing and configuring hard drives 179

 Configuring hard disk drives 182

 Rebuilding a hard disk in RAID 184

 Maintaining RAID hard drives 188
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Overview

Introduction

A RAID card enables you to expand the capabilities of your server. This sec
describes the 1001rp server RAID system and the procedures for replacing
configuring its components. 

Included procedures

Procedures covered include the following:

� replacing a RAID card

� cabling a RAID system

� preparing to configure a RAID system

� creating a system drive

� initializing a system drive
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RAID system summary

Introduction

Redundant Arrays of Inexpensive Disks (RAID) is a technology that can 
combine two or more drives for fault tolerance and performance. Configure
drive bay in the 1001rp to RAID level 1 array using the optional hardware RA
controller, or as individual drives (non-RAID).

Drive array bays

There are six Single Connector Architecture (SCA) 3.5-inch full-width drive 
array bays available to add hot-pluggable disk drives.

RAID levels

The RAID controller is a PCIRAID SCSI card that provides high-performanc
disk mirroring. It is always installed in PCI slot 12. RAID Level 1 is always 
implemented.

� Level 1 - mirroring

Two equal-capacity disks mirror one another. One disk serves as the ba
copy of the other disk. If one drive fails, the other automatically replace
This level prevents loss of information and network time.

RAID software

The Windows NT operating system supports mirroring in software without a
hardware RAID controller. This software-only approach is not recommende
supported.

RAID and hot-swappable components

A RAID controller is also essential to hot-swap SCA SCSI hard drives. If yo
replace a drive during system operation without the RAID controller, hot-sw
device drivers, and operating system support, you can cause a fatal system
force a system restart, and cause data loss.
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Replacing the RAID card

Introduction

You can replace or upgrade your RAID card. Follow the procedures in this 
section to replace a RAID card and reconnect the cables.

Requirements

Before replacing the RAID card, gather the following tools:

� one Phillips screwdriver

� one antistatic wrist strap

� the replacement RAID card

To replace the RAID card

1 Review the manufacturer’s documentation for the replacement card.

2 Power down the server and disconnect all power cords.

3 Remove the chassis cover and locate the installed RAID card in PCI slot 
number 12.

4 Disconnect all cabling from the RAID card.

5 Use an adhesive label or a piece of tape to label each cable with its 
connection.

6 Loosen the screw located at the top of the card’s faceplate.

7 Remove the card from the chassis.

8 Unpack the replacement card.

9 Align the replacement card with PCI slot 12.

10 Apply downward pressure until the card is evenly and securely seated in 
the slot.

11 Secure the card by tightening the screw at the top of the faceplate.

Note: If you replace your RAID card and the system does not come up, call
Nortel Networks support.
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What’s next?

Once the card is secured on the chassis, reconnect the cables.
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Attaching cables to the RAID card

Introduction

Once you seat the RAID card firmly on the chassis, you need to connect ca
to the card. In a RAID configuration, use the SCSI Channel 1 to control the 
disks, and the SCSI Channel 0 to control the tape drive.

Requirements

To connect the RAID card cabling, you require the following:

� RAID cables for two header connections

Both header connections must be cabled. Refer to the connections as 
Channel 0 and Channel 1

� a properly seated RAID card
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RAID card cabling with a Pentium II or III SBC

Note: This diagram applies to older drives. Newer drives do not have the sa
adapter.

SBC card

RAID card

To power
1

1

To power

To power

To hard drive

Channel 1

Channel 0

Active
terminator

68 to 50 
pin adapter
(optional for 
narrow tape 
drives)

CD ROM drive

Tape 
drive

Floppy drive
Part 5: 1001rp Server Maintenance and Diagnostics 177



Performing hardware maintenance  Standard 1.0

igure 
rives 

our 

. 
.

To cable hard disk drives in a RAID system

1 Connect a SCSI cable to Channel 1 on the RAID card.

2 Route the cable to the expansion card area through to the left side of the 
system, and down to the SCSI backplane.

Result: The SCSI backplane provides termination for this SCSI channel.

To cable a RAID system for a tape drive

1  Connect a second SCSI cable to Channel 0 on the RAID card.

2 Route the cable between the RAID card and the right side of the system 
chassis to the front of the chassis, and then down through the system to the 
tape drive.

3 Attach a wide SCSI active terminator as the last device on the cable.

Note: The NTRH9034 tape drive cannot provide SCSI bus termination. You 
must have an Active SCSI terminator as the last device on the SCSI cable. 
Ensure that the jumper labeled TPWR is enabled on the tape drive. The 
tape drive must always be connected to the second last connector on the 
SCSI cable.

� Wide active terminator (Part number A0766997)
The wide active terminator must be connected to the last connector on 
the SCSI cable.

What’s next?

Once you have installed and cabled the RAID card, you do not need to conf
the card. Power up the system. The card reads the configuration from the d
and configures itself.

Note: If you replace your RAID card and the system does not come up, call y
Nortel Networks customer support representative.

. 

CAUTION

Risk of equipment damage

Ensure that no cable touches any SBC card component
Heat transfer often causes serious damage to the system
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Replacing and configuring hard drives

Introduction

Replace any of the six SCSI hot-swappable drives from the drive bay if they
should fail, or if you want to upgrade. The 1001rp server also operates one
additional hard drive from the media drive bay that you can replace. Once y
replace hard drives, configure them.

Replacing hard drives
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RAID SCSI hard drive configuration

The table below indicates proper SCSI drive bay, channel, and ID configurat
in the hot-swappable drive bay. The SCSI backplane sets SCSI IDs: as follo

Non-RAID SCSI hard drive configuration

The table belowindicates proper SCSI drive bay, channel, and ID configurat
in the hot-swappable drive bay. The SCSI backplane sets SCSI IDs as follo

Hard drive bay SCSI unit SCSI ID

1 (A-0) Channel 1, ID 0

4 (A-1) Channel 1, ID 3

2 (B-0) Channel 1, ID 1

5 (B-1) Channel 1, ID 4

3 (C-0) Channel 1, ID 2

6 (C-1) Channel 1, ID 5

Front bay Tape drive Channel 0, ID 6

Hard drive bay SCSI unit SCSI ID

1 (A-0) SCSI ctrl, ID 0

4 N/A SCSI ctrl, ID 3

2 (B-0) SCSI ctrl, ID 1

5 N/A SCSI ctrl, ID 4

3 (C-0) SCSI ctrl, ID 2

6 N/A SCSI ctrl, ID 5

Front bay Tape drive SCSI ctrl, ID 6
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Note: Do not install drive bays 4, 5, and 6 in the standard non-RAID 
configuration.

If you have a SCSI CD-ROM drive in a non-RAID hard drive configuration, th
the tape drive must have the following SCSI IDs:

To set SCSI IDs and disable termination

1 Set SCSI IDs to 0. Disable termination.

2 Check that the SCSI ID of the tape drive matches the table on the previous 
page.

3 Ensure that Parity Checking is enabled on the tape and disks.

4 Check that the tape drive is configured to enable termination for its SCSI 
channel.

Note: You require a wide (68-pin) to narrow (50-pin) connector to connect a 
narrow tape drive to the wide SCSI bus.

What’s next?

Once you have set the SCSI IDs, configure the system for specific drive 
capacities.

Hard drive bay SCSI unit SCSI ID

Front bay Tape drive SCSI ctrl, ID 6
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Configuring hard disk drives

Introduction

Your requirements determine the capacity of a system. Drives C-0 and C-1 
might not exist in a standard RAID configuration. The procedures for 
configuring each drive capacity are listed below.

Note: The following serves as an example only. Other combinations are pos
depending on your application.

Hard drive location

The following table indicates the relative physical location of hard drives an
their associated capacity:

Note: Drive bays can be either 4 Gbyte or 9 Gbyte.

To configure hard disk drives

1 Use the “Hard drive location” table above to determine the appropriate drive 
bay for installation.

2 Configure the hard drive to have no termination.

Result: The SCSI backplane handles proper termination of the SCSI bus.

Note: In a non-RAID configuration, only drives A-0 and B-0 are installed for 
a 13 Gbyte configuration. C-0 is installed only if the intended configuration 
is 22 Gbyte.

In a RAID configuration, drives A-0, A-1, B-0, and B-1 are installed for a 13 
Gbyte configuration. C-0 and C-1 are installed only if the intended 
configuration is 22 Gbyte.

Drive bay 
1

Drive bay 
2

Drive bay 
3

Drive bay 
4

Drive bay 
5

Drive bay 
6

9 Gbyte 9 Gbyte 9 Gbyte 9 Gbyte 9 Gbyte 9 Gbyte

A-0 B-0 C-0 A-1 B-1 C-1
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What’s next?

Once you have configured the capacity of your drives, configure the drives 
part of a RAID or non-RAID system.
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Rebuilding a hard disk in RAID

Introduction

In RAID level 1, two equal-capacity disks mirror one another. Both drives ru
simultaneously with one disk serving as the backup copy of the other disk. If
drive fails, the other continues to run. When the failed drive is physically 
replaced with a new one, the data on the operating drive of the system pack
be copied onto the new drive to rebuild it. RAID automatically performs this
rebuild process when the replacement drive is accessed.

If you would like to start the initiation process sooner, or monitor the rebuild
process, use the the DAC Administration software that is installed on the sy

Before you begin

Perform this procedure in response to the system message that a hard disk
failed. The message displays information about drive location. Perform this
procedure while the system is powered on.
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To rebuild a hard disk in a RAID system

1 Observe the warning message given by the DAC Monitor software, which 
indicates a hard drive failure.

2 Record the SCSI channel SCSI ID of the drive that failed from the 
information in the DAC Monitor window.

3 Identify which drive drive failed using this information and referring to the 
tables contained on pages 180 and 182.

4 Shutdown Windows NT and power down the server.

5 Remove the failed hard disk.

6 Replace the failed hard disk with a new hard disk.

7 Power up the server and log on to Windows NT.

8 Click the DAC Administration icon.
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9 Choose Rebuild Drive from the Management menu.

10 Click the drive marked DED.
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11 When the rebuild completes, click OK.

Note: This procedure takes from five minutes to one hour, depending on 
the size of the drive.

12 After the procedure is complete, close the application.
Part 5: 1001rp Server Maintenance and Diagnostics 187



Performing hardware maintenance  Standard 1.0

 be 
s 
Maintaining RAID hard drives

Introduction

RAID hard drives must be checked for errors on a weekly basis. Errors can
reviewed with the help of the DAC Admin Windows NT software utility that i
installed on the server. 

To review errors detected on a RAID hard disk

1 Click the Start Menu.

2 Click Run.

3 Type dacadm.exe.

4 Click OK.

Result: This starts the DACAdmin software utility.

5 Click the Configuration menu.

6 Choose Drive Information on the Configuration menu.

Result: A list of all hard disks connected to the RAID controller appears.

Note: Hard disks marked ONL are online and part of a RAID System pack.

7 Click on a drive to see a summary of errors.

a. If there are ten or more soft errors per day, replace the drive.

b. Hard errors should not occur during normal operation. Contact your 
Nortel Networks customer support representative if errors are 
accumulating.

c. Miscellaneous Errors are typically due to cabling or termination 
problems on the SCSI bus. Verify jumper settings on all SCSI devices 
and ensure that cabling is secure.

d. When the total number of errors reaches 127, the controller marks the 
drive DED. DED means offline. The drive must be replaced.

8 Repeat step 7 on all hard disk drives listed.

9 Close the configuration menu.

10 Exit from the DAC Admin software utility.
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Section C: Device settings

In this section
 Overview 190

 Pentium II or III slot assignments 191

 IRQ mapping table 192
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Overview

Introduction

This section describes device settings for the 1001rp server.

Procedures covered include the following:

� slot assignments for the 1001rp server configurations

� IRQ mapping for the 1001rp server

1001rp backplane showing ISA/SBC/PCI slots
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Pentium II or III slot assignments

Slot Device

ISA Slot 1 CLAN Network Card (if ISA)

ISA Slot 2 Available for application

ISA Slot 3 Available for application

ISA Slot 4 Available for application

ISA Slot 5 Available for application

ISA Slot 6 Available for application

ISA Slot 7 Available for application

SBC Slot Pentium II or Pentium III Single Board Computer

PCI Slot 1 Reserved for COM1 and COM2 I/O Bracket

PCI Slot 2 ELAN Network Card

PCI Slot 3 CLAN Network Card (if PCI)

PCI Slot 4 Available for application

PCI Slot 5 Available for application

PCI Slot 6 Available for application

PCI Slot 7 Available for application

PCI Slot 8 Available for application

PCI Slot 9 Available for application

PCI Slot 10 Available for application

PCI Slot 11 VGA Card (if PCI)

PCI Slot 12 PCI RAID Controller
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IRQ mapping table

Introduction

The IRQ table for the 1001rp Server applies to both Single Board Compute
configurations. In addition, note that IRQs 9, 10, 11, and 15 are assigned to
system PCI slots rather than to specific devices. 

IRQ Slot/Device

0 Timer

1 Keyboard

2 System / Unused

3 Serial Port 2 (COM2)

4 Serial Port 1 (COM1)

5 CLAN Network Interface (if ISA) otherwise available

6 Floppy Controller

7 Parallel Port (LPT1)

8 Real Time Clock

9 Assigned to PCI Slots 1, 7, and 12

10 Assigned to PCI Slots 2, 5, and 11

11 Assigned to PCI Slots 3, 6, and 9

12 PS/2 Mouse

13 Math Coprocessor

14 Primary EIDE Controller

15 Assigned to PCI Slots 4, 8, and 10
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Section D: Video card

In this section
 Overview 194

 Troubleshooting the video card 195

 Replacing the video card 196
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Overview

Introduction

This section describes procedures for handling and replacing video cards o
1001rp server.

Included procedures

Procedures covered include the following:

� troubleshooting the video card

� identifying the video card

� determining slot assignment

� replacing the video card
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Troubleshooting the video card

Video card function

The video card takes information from the computer and displays it on the 
installed monitor.

Indicators for card replacement

If the monitor appears to be functioning but no display is visible, look for the
following indicators of video card malfunction. If the server is consistent wit
these indicators, replace the video card:

� Brightness and contrast are set at normal level.

� The server is powered on and one long beep is followed by two short b

� The floppy drive light goes on when the server is powered, but no displa
visible on the monitor.

� The floppy drive light comes on when the user types dir a: and presses
Enter, but no display is visible on the monitor.
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Replacing the video card

Introduction

If you determine that a problem exists with your video card, replace the car
You need to identify the type of card before you can decide where to install

Requirements

To replace the video card, you require the following:

� one Phillips screwdriver

� one antistatic wrist strap

� the replacement video card

Identify the card

Identify a video card from other types of cards by its connector. To identify a
installed video card, look at the card to which the installed monitor connects
no monitor is connected, look for the card to which a monitor normally 
connects. 

To replace the video card

1 Review the manufacturer’s documentation for the replacement video card.

2 Power down the server and disconnect all power cords.

3 Refer to the table on page 191 to determine proper slot assignment.

4 Remove the chassis cover to expose the installed cards.

5 Set aside any cables covering the video card.

Note: The video card has no internal cable connectors itself.

6 Free the card from the faceplate by loosening the screw.

7 Lift the card out of the slot and set it aside.

8 Unpack the replacement card and align it with the proper slot.
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9 Apply downward pressure until the card is evenly and securely seated in 
the slot. 

10 Secure the card by tightening the screw located at the top of the faceplate.

11 Replace the chassis cover.

What’s next?

Perform system diagnostics procedures after you install or replace any serv
component.
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Section E: Optional cards

In this section
 Overview 200

 Replacing ELAN cards 201

 Replacing Ethernet CLAN cards 206

 Replacing Token Ring CLAN cards 209
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Overview

Introduction

This section describes the network cards approved for use in the 1001rp se

Procedures covered include the following:

� slot assignments for optional cards

� installing and configuring network cards

Minimum requirements

Minimum system requirements for all servers include the installation of a 
network card. Install optional network cards according to server configuratio

Slot assignments described in this section show the proper location for requ
and optional network cards.

Pentium II or III slot assignments

Refer to “Pentium II or III slot assignments” on page 191.
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Replacing ELAN cards

Introduction

The ELAN network card is a minimum system requirement for the 1001rp 
server. Although the card must always be an Ethernet card installed in a PC
it can be either Intel or 3Com.

To replace an ELAN network card

1 Check the slot assignment table on page 191 to determine proper slot 
assignment.

2 Check that the BIOS is configured to assign the correct IRQ to the correct 
slots.

3 Remove the chassis cover to expose the installed cards.

4 Disconnect external network cables.

5 Check the installed card to ensure that it is the ELAN network card. 

6 Set aside any cables covering the card.

Note: The network card has no internal cable connectors.

7 Free the card from the faceplate by loosening the screw.

8 Lift the card out of the slot and set it aside.

9 Unpack the replacement card and insert it into the proper slot.

10 Align the card with the faceplate and secure it by tightening the screw.

11 Replace the chassis cover.

12 Connect the ELAN network cable.

What’s next?
� Add the appropriate network card driver if the new installed card is a 

different make/model from the failed card.

� You must remove the old ELAN card driver if the new installed card is a
different make/model from the failed card.

� Run diagnostic software (typically installed with the driver).
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To install an ELAN network card driver

1 Restart and log on to the server as Administrator.

2 Open the Network Control Panel and select the Adapters tab. 

3 Click Add... to add the adapter.
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4 Click Have Disk... to load the device driver.

5 Insert the driver disk for the ELAN network card in the floppy drive and 
press Enter.

6 If the driver disk contains drivers for more than one network card, the 
system prompts you to select the driver you want to install. Choose the 
driver that matches the installed ELAN card and click OK.
Part 5: 1001rp Server Maintenance and Diagnostics 203



Performing hardware maintenance  Standard 1.0
7 Click OK when the following screen appears:

Note: You only see this if ELAN and CLAN are the same.

Result: Some files are copied to the system and the new network card is 
listed in the network dialog box.

Note: Screen shots are not included for specific cards as they might be 
different depending on your configuration. If you need help installing a 
driver, call your Nortel Networks customer support representative.

8 Click Close to close the network control panel.

9 The TCP/IP properties panel appears.
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10 Select the new driver installed in the Adapters box.

11 Enter the customer-supplied IP address.

12 Click OK.

Result: You are prompted to restart the computer.

13 Click Yes.
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Replacing Ethernet CLAN cards

To replace the 3Com PCI Ethernet card

1 Review the slot assignments on page 191 to install the PCI CLAN network 
card in the appropriate slot.

2 Check that the BIOS is configured to assign the correct IRQ to the correct 
slots.

3 Power down the server.

4 Unplug the AC power cord.

5 Remove the chassis cover.

6 Locate the CLAN Ethernet card to be removed, and unplug its network 
cabling.

7 Set aside any cables covering the card.

8 Remove the screw that fastens the card in the chassis.

9 Gently pull the card out (use a slight rocking motion).

10 Remove the new Ethernet card from its protective packaging.

Note: Place the old Ethernet card into the protective packaging.

11 Line up the new Ethernet card with the slot (PCI or ISA, as appropriate). 

Note: Make sure the end-plate tab is lined up with the opening in the 
chassis.

12 Press the card into the slot. 

13 Secure the card to the server chassis with the fastening screw.

14 Replace the chassis covers.

15 Plug in the AC power cord.

. 

CAUTION

Risk of equipment damage
Ensure that the card is completely seated or the card will 
short-circuit.
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16 Power up the server.

To install a 3Com PCI Ethernet network card driver

1 Start with Windows NT and log on to the server as Administrator.

2 Open the Network Control Panel, select the Adapters tab, and Click Add... 
to add the adapter.

3 Click Have Disk... to load the device driver.

4 Insert the 3Com device driver disk for the CLAN card and press Enter.

5 Select 3Com Fast Ethernet 3C900 card and click OK.

6 Click Close to close the network control panel and configure the network 
card.

7 Enter the TCP/IP information for the card.

Note: The customer must provide this information.

8 Click OK to close the TCP/IP configuration screen.

9 Click Yes to restart the computer.

To replace an Intel PCI Ethernet card

1 Review the slot assignments on page 191 to install the PCI CLAN network 
card in the appropriate slot.

2 Check that the BIOS is configured to assign the correct IRQ to the correct 
slots.

3 Power down the server.

4 Unplug the AC power cord.

5 Remove the chassis cover.

6 Locate the CLAN Ethernet card to be removed, and unplug its network 
cabling.

7 Set aside any cables covering the card.

8 Remove the screw that fastens the card in the chassis.

9 Gently pull the card out (use a slight rocking motion).
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10 Remove the new Ethernet card from its protective packaging.

Note: Place the old Ethernet card into the protective packaging.

11 Line up the new Ethernet card with the slot (PCI or ISA, as appropriate). 

Note: Make sure the end-plate tab is lined up with the opening in the 
chassis.

12 Press the card into the slot. 

13 Secure the card to the server chassis with the fastening screw.

14 Replace the chassis covers.

15 Plug in the AC power cord.

16 Power up the server.

To install an Intel PCI Ethernet network card driver

1 Start with Windows NT and log on to the server as Administrator.

2 Open the Network Control panel, select the Adapters tab, and click Add... to 
add the adapter.

3 Click Have Disk... to load the device driver.

4 Insert the Intel device driver disk for the CLAN card and press Enter.

5 Select Intel EtherExpress PRO/100B PCI Ethernet Adapter, and click OK.

6 Click Close to close the network control panel and configure the network 
card.

7 Enter the TCP/IP information for the card.

Note: The customer must provide this information.

8 Click OK to close the TCP/IP configuration screen. Click Yes to restart the 
computer.

. 

CAUTION

Risk of equipment damage
Ensure that the card is completely seated or the card will 
short-circuit.
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Replacing Token Ring CLAN cards

To replace the Racore PCI Token Ring card

1 Review slot assignments on page 191 and install the PCI CLAN network 
card in the appropriate slot.

2 Power down the server.

3 Unplug the AC power cord.

4 Remove the chassis covers.

5 To make access to the internal components easier, turn the server over on 
its side.

6 Locate the PCI Token Ring card to be removed, and unplug its network 
cabling.

7 Remove the screw that fastens the card in the chassis.

8 Gently pull the card out (use a slight rocking motion).

9 Remove the new PCI Token Ring card from its protective packaging.

Note: Place the old PCI Token Ring card into the protective packaging.

10 Line up the new PCI Token Ring card with the PCI slot.

Note: Make sure the end-plate tab is lined up with the opening in the 
chassis.

11 Press the card into the slot. 

12 Secure the card to the server chassis with the fastening screw.

13 Stand the server up, and replace the chassis covers.

14 Plug in the AC power cord.

15 Power up the server.

. 

CAUTION

Risk of equipment damage
Ensure that the card is completely seated or the card will 
short-circuit.
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To install a Racore PCI Token Ring card driver

1 Start with Windows NT and log on to the server as Administrator.

2 Open the Network Control panel, and select the Adapters tab.

3 Click Add... to add the adapter, and click Have Disk... to load the device 
driver.

4 Insert the Racore device driver disk for the CLAN card, type a:\windows.nt  
as the path to the driver, and press Enter.

5 Select Racore Preferred Token Ring NDIS Driver, and click OK.

6 Type the following information in the appropriate fields:

� I/O: PCI

� IRQ: 5 (or 10 if PCI and MMX SBC; or 11 if PCI and PII SBC)

� DMA: Autodetect

� Memory Address: Autodetect

� Network Address: (leave blank)

� Speed: 16 Mbytes (leave the rest of field as is)

� Bus Number:
Select the appropriate bus number from the list below:
PCI slot # 1 = Bus 1
PCI slot # 2 = Bus 1
PCI slot # 3 = Bus 1
PCI slot # 4 = Bus 1
PCI slot # 5 = Bus 2
PCI slot # 6 = Bus 2
PCI slot # 7 = Bus 2
PCI slot # 8 = Bus 2
PCI slot # 9 = Bus 3
PCI slot # 10 = Bus 3
PCI slot # 11 = Bus 3
PCI slot # 12 = Bus 3

� Bus Type: PCI

Note: The last two fields appear in a separate dialog box.

7 Click Close to close the Network Control Panel and configure the network 
card.
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8 Enter the TCP/IP information for the card.

Note: The customer must provide this information.

9 Click OK to close the TCP/IP configuration screen. 

10 Click Yes to restart the computer.

To replace the Madge ISA Token Ring card

1 Use the BIOS Configuration utility to check that IRQ5 is available.

Note: Go to the Advanced section of the BIOS and, under PCI Devices, 
ensure that IRQ5 is not assigned to a PCI IRQ Line.

2 Review slot assignments and install the ISA CLAN network card.

3 Power down the server.

4 Unplug the AC power cord.

5 Remove the chassis covers.

6 To make access to the internal components easier, turn the server over on 
its side.

7 Locate the PCI Token Ring card to be removed, and unplug its network 
cabling.

8 Remove the screw that fastens the card in the chassis.

9 Gently pull the card out (use a slight rocking motion).

10 Remove the new PCI Token Ring card from its protective packaging.

Note: Place the old PCI Token Ring card into the protective packaging.

11 Line up the new PCI Token Ring card with the PCI slot.

Note: Make sure the end-plate tab is lined up with the opening in the 
chassis.

12 Press the card into the slot. 

. 

CAUTION

Risk of equipment damage
Ensure that the card is completely seated or the card will 
short-circuit.
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13 Secure the card to the server chassis with the fastening screw.

14 Stand the server up, and replace the chassis covers.

15 Plug in the AC power cord.

16 Power up the server.

To install a Madge ISA Token Ring card driver

1 Start the server from the Madge Install disk.

Note: If the disk supplied is not in a bootable format, refer to Standard 
Procedures.

2 Press any key once the title screen appears. Press F3 to configure software 
configurable ringnodes.

3 Select the SMART 16/4 AT PLUS RINGNODE.

Verify the following information and press Enter to configure the 
information:

� Transfers: 16 bit Bus Master

� I/O Port: 0A20

� Ring Speed: 16 Mbytes

� IRQ: 5

� SmartROM: Disabled

4 Press F5 to confirm that the hardware profile matches the configuration.

Note: If the configuration does not match, check the DIP switches.

5 Verify the following information and press F8 to configure:

� DMA: 5

� I/O Width: 16 bit

� Bus Timing: Normal

� Bus Mode: Asynch

6 Press F4 to complete the configuration. 

7 Restart and log on to the server as Administrator.

8 Open the Network Control Panel and select the Adapters tab. Click Add... 
to add the adapter.
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9 Click Have Disk... to load the device driver.

10 Insert the Madge Device Driver disk for the CLAN card.

a. Type a:\winnt.35  as the path to the driver.

b. Press Enter.

c. Select SMART 16/4 AT PLUS RINGNODE (BM).

d. Click OK.

11 Type the following information in the appropriate fields:

� I/O Location: 0x0a20

� IRQ: 5

� DMA: 5

� Number of Processors: Multiple

� Max Frame Size: 4096

� LAA: (leave blank)

� Rx/Tx Buffers: Rx=04, Tx=04

� Traffic Statistics Gathering: Enabled

� Ring Speed: Set at Adapter (leave the rest of the field as is)

� Bus Type: ISA

� Bus Number: 0

Note: The last two fields appear in a separate dialog box.

12 Click Close to close the Network Control Panel and configure the network 
card.

13 Enter the TCP/IP information for the card. 

Note: The customer must provide this information.

14 Click OK to close the TCP/IP configuration screen.

15 Click Yes to restart the computer.
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Section F: The Pentium II SBC card

In this section
 The Pentium II SBC card 216

 Replacing the Pentium II SBC card 218

 Upgrading the BIOS 220

 Dual Inline Memory Modules 232
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The Pentium II SBC card

Introduction

This section describes the Pentium II or Pentium III Single Board Computer
(SBC) cards. It covers procedures for replacing and configuring the SBC ca

Procedures included

Procedures covered include the following:

� replacing the SBC card

� upgrading and configuring the BIOS

� adding memory DIMMs to the SBC

Intended audience

This section is written primarily for field service technicians. It is intended to 
as a guide for installing, repairing, replacing, and upgrading hardware and 
software components. This section assumes that the reader has basic com
skills, is familiar with necessary safety procedures, and has the hardware 
documentation provided by the manufacturer available as a reference. This 
information applies to the 1001rp server only. 
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The Pentium II SBC
Part 5: 1001rp Server Maintenance and Diagnostics 217



Performing hardware maintenance  Standard 1.0

 and 
. 

sion 

ur 
 the 
Replacing the Pentium II SBC card

Introduction

You should replace the SBC card when it fails. Use system diagnostic tools
refer to error codes to determine whether the SBC card should be replaced

The SBC is always installed in the SBC slot located between the ISA expan
slots and the PCI slots on the backplane. The board features headers for 
peripheral connections, jumper blocks, and DIP switches. It also features fo
DIMM sockets to support up to 512 Mbytes of Fast Page Mode memory on
Pentium II SBC.

Requirements

Before replacing the SBC card, gather the following tools:

� one Phillips-head screwdriver

� one antistatic wrist strap

� the replacement SBC card

� cable labels

To replace the SBC card

1 Power down the server.

2 Disconnect the power cord. 

3 Remove the top cover.

4 Free and label all connectors from the SBC card.

5 Loosen and remove the screw located at the top of the I/O bracket.

6 Remove the I/O bracket.

7 Loosen and remove the screw located at the top of the card’s faceplate.

8 Loosen the SBC and pull it up from the backplane.

9 Remove the new card from its protective wrapping.
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10 Align the card with its slot on the backplane and press it into place. 

Result: The board seats properly in both the ISA-style and PCI-style 
connectors.

11 Fasten the card down with the screw provided.

12 Install the new I/O bracket.

13 Fasten the I/O bracket using the screw provided.

14 Remove the labels attached to all connectors and reconnect them to the 
card.

15 Replace the top cover.
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Upgrading the BIOS 

Introduction

BIOS is the Basic Input/Output System of the computer. It is Flash ROM-ba
code. The system is equipped with Flash BIOS, which enables you to upgra
by running a single program that writes updated code to the Flash ROM ch

When to configure the BIOS

BIOS configuration is necessary for first-time setup. Reconfigure the BIOS a
a BIOS or CMOS failure and recovery.

Requirements
� You need a bootable upgrade disk. For the Pentium II SBC, the Texas 

Micro BIOS release number must be 4.06.1.5c.

Contact your Nortel Networks customer support representative 
organization to request a BIOS upgrade disk.

� You must perform both of the following procedures to upgrade the BIO

� upgrading the BIOS

� configuring the SBC
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DIP switch block on the Pentium II SBC

To upgrade the BIOS

1 Insert the bootable BIOS upgrade disk into drive A and power on the server.

Note: You can obtain a BIOS upgrade disk from your Nortel Networks 
customer representative.

2 Allow the flash process to complete.

3 Power down the system.

4 Remove the top cover.

5 Set DIP switch 3 to the ON position.
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6 Power on the server.

Result: A message appears on the boot screen that the system is loading 
BIOS defaults.

7 Power off the server after seeing the above message.

8 Return DIP switch 3 to the OFF position.

9 Replace the top cover.

10 Restart the system.

11 Configure the BIOS as described in the following procedure.

To configure the Pentium II SBC BIOS

1 Power on the system and press F2 to enter the CMOS Setup.

Note: For the following steps, use the arrow keys to navigate menus, and 
press Enter to make a selection.

Result: The Setup Utility starts. The screen has two areas:

� Options: The Options menu is on the left side of the screen, and is 
composed of Basic options, Advanced options, and PCI options.

� Summary Information: The current settings appear on the right side of 
the screen.

2 Select the items described in the tables that follow.

Crisis recovery

There are special cases when the BIOS data is corrupted or an invalid user
configuration has been entered, an incorrect BIOS file has been flashed. In 
cases, the SBC does not start at all or it displays nothing on the screen.

To recover the BIOS

1 Use the Nortel Network’s NTRH8042 disk to create the Crisis recovery 
disk.

a. In DOS mode, copy the contents of the NTRH8042 disk on a temporary 
directory.

b. Label a new disk Crisis Recovery.

c. Insert the Crisis Recovery disk into drive A.
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d. At the DOS prompt, type crisdisk.

e. Press Enter.

f. After the disk is done, at the DOS prompt, type makeboot .

g. Press Enter. Power off the server.

2 Identify Switch Block (SW1) on the SBC. The Switch Block contains four M 
access, CMOS RAM, and configuration ports. Set dip switch number 2 to 
the closed/on position.

Note: The default position set on the switch is open/off.

3 Insert the Crisis Disk into the floppy drive.

4 Power on the server.

Result: You hear a series of beeps.

Note: During this process, the only devices that work are the floppy 
controller, floppy drive, and speaker. There is no display.

5 When you do not hear any beeps (approximately 15 seconds), remove the 
disk and power off the server.

6 Return switch number 2 back to the default position of open/off.

7 Power on the server.

Result: The SBC should restart normally and prompt you to enter into 
setup.

Pentium II BIOS basic options

Note: You must first load the defaults by pressing F9.

Item Option Default setting CallPilot setting

Time and Date Set time and date N/A Current Date/Time

Floppy Disks Floppy Controller Enabled Enabled

Select drive A Type 3.5” 1.44 Mbytes 3.5” 1.44 Mbytes

Select drive B Type Not Installed Not Installed

IDE Adapter 0 Master CD-ROM CD-ROM
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Slave None None

IDE Adapter 1 Master None None

Slave None None

Fixed Disks IDE Controller 
Setup

Primary
(1F0-1F7h)

Primary
(1F0-1F7h)

Auto Detect IDE 
Drives

Enabled Enabled

Large Disk DOS 
Compatible

Enabled Enabled

Set Hard Disk
1/2 / 3/4 Type

N/A N/A

Cache Memory Memory Cache Enabled Enabled

Cache System 
BIOS area

Write protect Write protect

Cache Video BIOS 
area

Write protect Write protect

Cache Base
0–512 kbytes

Write back Write back

Cache Base
12 kbytes–640 
kbytes

Write back Write back

Cache Extended 
Memory area

Write back Write back

Cache A000–AFFF Disabled Disabled

Cache B000–BFFF Disabled Disabled

Cache C800–CBFF Disabled Disabled

Cache CC00–CFFF Disabled Disabled

Item Option Default setting CallPilot setting
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Cache D000–D3FF Disabled Disabled

Cache D400–D7FF Disabled Disabled

Boot Options Summary screen Enabled Enabled

Floppy check Enabled Enabled

Quiet boot Disabled Disabled

Post errors Disabled Disabled

Keyboard features Numlock Auto Auto

Key click Disabled Disabled

Keyboard auto 
repeat rate

30/sec 30/sec

Keyboard auto 
repeat delay

1/2 sec 1/2 sec

System Memory Verify only

Extended Memory Verify only

Item Option Default setting CallPilot setting
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Pentium II BIOS advanced options

Item Option
Default 
setting CallPilot setting

Integrated 
Peripherals

Serial Port A Enabled Enabled

Serial Port A: Base
I/O Address

3F8 3F8

Serial Port A: 
Interrupt

IRQ 4 IRQ 4

Serial Port B Enabled Enabled

Serial Port B: 
Mode

Normal Normal

Serial Port B: Base
I/O Address

2F8 2F8

Serial Port B: 
Interrupt

IRQ 3 IRQ 3

Parallel Port Enabled Enabled

Parallel Port: Mode Bidirectional Bidirectional

Parallel Port: Base
I/O Address

378 378

Parallel Port: 
Interrupt

IRQ 7 IRQ 7

Floppy Disk 
Controller

Enabled Enabled

Floppy Disk 
Controller: Base I/
O Address

Primary Primary

Local Bus IDE 
Adapter

Enabled Enabled
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Adaptec Ultra 
SCSI Adapter

Disabled Enabled for non-RAID

Disabled for RAID

SCSI Adapter 
Frequency

Note: This is only 
an option if the 
Adaptec Ultra 
SCSI Adapter is 
enabled.

40 MHz 40 MHz

Advanced 
Chipset Control

DRAM Speed nothing 
displayed

Do not change.

ECC/Parity Config ECC Gen & 
Correct

Parity Gen & Correct

Enable Memory 
Gap

Disabled Disabled

Release E000 Disabled Disabled

DMA Aliasing Enabled Enabled

8-bit I/O Recovery 4.5 4.5

16-bit I/O 
Recovery

4.5 4.5

ISA Bus Speed PCI Clock / 
4 (8.33 
MHz)

PCI Clock / 4 (8.33 MHz)

Watchdog Timer 
Status

Disabled Disabled

Watchdog Timer 
Delay

150 ms 150 ms

Item Option
Default 
setting CallPilot setting
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PCI 
configuration

PCI IRQ Line 1 IRQ 9 IRQ 9

PCI IRQ Line 2 IRQ 10 IRQ 10

PCI IRQ Line 3 IRQ 11 IRQ 11

PCI IRQ Line 4 IRQ 15 IRQ 15

ISA Graphics 
Device Installed

No Yes

PCI/PNP ISA 
UMB Region 
Exclusion
C800 - DFFF

Available Available

PCI/PNP ISA IRQ 
Resource 
Exclusion:
IRQ3, IRQ4, IRQ5, 
IRQ7, IRQ9, 
IRQ10, IRQ11, 
IRQ12, IRQ14, 
IRQ15

Available Reserve IRQ5 if installing 
ISA CLAN card.

PS/2 Mouse Enabled Enabled

Onboard Speaker Enabled Enabled

Item Option
Default 
setting CallPilot setting
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Pentium II BIOS security options

Use 
Multiprocessor 
Spec

1.1 1.4

CPU BIOS 
Update

Enabled Enabled

Plug & Play OS No No

Secured Setup 
Configuration

Yes Yes

Large Disk 
Access Mode

DOS DOS

Item Option Default setting CallPilot setting

Supervisor 
Password is

Clear Clear

User Password is Clear Clear

Set Supervisor 
Password

Clear Enter

Set User Password Clear Enter

Item Option
Default 
setting CallPilot setting
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Pentium II BIOS power options

Password on Boot Disabled Disabled

Fixed Disk Boot 
Sector

Normal Normal

Disk Access Supervisor Supervisor

Virus Check 
Reminder

Disabled Disabled

System Backup 
Reminder

Disabled Disabled

Item Option Default setting CallPilot setting

Power Savings Disabled Disabled

Standby Timeout Off Off

Auto Suspend 
Timeout

Off Off

Hard Disk Timeout Disabled Disabled

Video Timeout Disabled Disabled

Resume on Modem 
Ring

Off Off

Resume on Time Off Off

Item Option Default setting CallPilot setting
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Pentium II BIOS boot options

Pentium II BIOS server options

IRQ mapping table

Refer to “ IRQ mapping table” on page 192.

Default settings CallPilot setting

Disk Drive Disk Drive

Hard Drive ATAPI CD-ROM Drive

ATAPI CD-ROM Drive Hard Drive

Hard drive Option

Hard Drive SCSI Hard Drive

Item Option Default setting CallPilot setting

Console Redirect 
Port

Disabled Disabled

Console Redirect 
Baud Rate

9600 57600
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Dual Inline Memory Modules

Introduction

Dual Inline Memory Modules (DIMMs) are the memory modules located on 
SBC. The gold-plated edge connectors on DIMMs are designed to plug into
matching edge-connector slots. The design allows you to add or remove th
modules repeatedly without tools or damage. Install DIMMs on the Pentium
SBC only.

Capacity

Use 168-pin Fast Page Mode (FPM) parity DRAM utilizing DIMM technolog
with 60ns access times. A module has a capacity of 32, 64, or 128 Mbytes.
DIMMs require only one slot filled to compose a bank. There are four slots 
banks on the SBC. Install DIMMs in any slot, combination, or order. It is 
recommended that bank 0 (DIMM 1) be filled to enable troubleshooting 
procedures. Install up to 512 Mbytes of memory.

DIMM slots on a Pentium II SBC
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Requirements

To add DIMMs to the card, you require the following:

� an antistatic wrist strap

� DIMMs with gold-plated edge connectors

To add DIMMs to the SBC card

1 Remove the SBC card from the server.

Note: To remove old DIMMs, perform steps 2 and 3. To add new DIMMs, go 
to step 5.

2 Push the DIMM release tab outwards at both sides of the DIMM to be 
removed.

3 Hold the DIMM by its edges, being careful not to touch its components. 
Remove the DIMM by lifting it away from its slot. Store it in an antistatic 
package.

4 Remove other DIMMs as necessary.

5 Orient the DIMM so that the two notches in the bottom edge of the DIMM 
align with the keyed slot.

6 Insert the bottom edge of the DIMM into the slot and press down firmly on 
the DIMM until it seats correctly.

Note: When the DIMM seats correctly, release tabs lock back to an upright 
position. If the DIMM does not seat correctly, remove it and reinstall. Do not 
force the locking tabs to close.

7 Repeat the above two steps to install each additional DIMM.

8 Replace the SBC card in the server.
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Section G: The Pentium III SBC card

In this section
 The Pentium III SBC card 236

 Replacing the Pentium III SBC card 237

 Upgrading the BIOS 239

 Dual Inline Memory Modules 249
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The Pentium III SBC card

Introduction

This section describes the Pentium III Single Board Computer (SBC) card. 
covers procedures for replacing and configuring the SBC card.

Procedures included

Procedures covered include the following:

� replacing the SBC card

� upgrading and configuring the BIOS

� adding memory DIMMs to the SBC

Intended audience

This section is written primarily for field service technicians. It is intended to 
as a guide for installing, repairing, replacing, and upgrading hardware and 
software components. This section assumes that the reader has basic com
skills, is familiar with necessary safety procedures, and has the hardware 
documentation provided by the manufacturer available as a reference. This 
information applies to the 1001rp server only. 
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Replacing the Pentium III SBC card

Introduction

You should replace the SBC card when it fails. Use system diagnostic tools
refer to error codes to determine whether the SBC card should be replaced

The SBC is always installed in the SBC slot located between the ISA expan
slots and the PCI slots on the backplane. The board features headers for 
peripheral connections, jumper blocks, and DIP switches. It features two DI
sockets to support up to 512 Mbytes (two 256 Mbytes modules SDRAM EC
of Fast Page Mode memory on the Pentium III SBC.

Requirements

Before replacing the SBC card, gather the following tools:

� one Phillips-head screwdriver

� one antistatic wrist strap

� the replacement SBC card

� cable labels

To replace the SBC card

1 Power down the server.

2 Disconnect the power cord. 

3 Remove the top cover.

4 Free and label all connectors from the SBC card.

5 Loosen and remove the screw located at the top of the I/O bracket.

6 Remove the I/O bracket.

7 Loosen and remove the screw located at the top of the card’s faceplate.

8 Loosen the SBC and pull it up from the backplane.

Note: You can now do the following:

� Replace the SBC with a new card. To replace it, continue with step 9.
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� Upgrade the SBC by adding DIMM(s) to the card. To upgrade it, refer to 
the procedure “To add DIMMs to the SBC card” on page 233.

� Set dip switch #3 to upgrade the BIOS.

9 Remove the new card from its protective wrapping.

10 Align the card with its slot on the backplane and press it into place. 

Result: The board seats properly in both the ISA-style and PCI-style 
connectors.

11 Fasten the card down with the screw provided.

12 Install the new I/O bracket.

13 Fasten the I/O bracket using the screw provided.

14 Remove the labels attached to all connectors and reconnect them to the 
card.

15 Identify the Switch Block (SW1) location on the SBC. The Switch Block 
contains four DIP switches (1–4) that you configure affecting on-board 
ROM access, CMOS RAM, and configuration ports. Ensure dip switch 
number 4 is set to the closed/on position. This setting ensures that 
configuration ports are set to I/O address 370–373.

Note: The default switch setting is open/off.

16 Replace the top cover.

. 

DANGER

Risk of explosion
The SBC has a lithium battery installed. If you are 
discarding the SBC, dispose of used batteries accordi
to the manufacturer’s instructions.
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Upgrading the BIOS

Introduction

BIOS is the Basic Input/Output System of the computer. It is Flash ROM-ba
code. The system is equipped with Flash BIOS, which enables you to upgra
by running a single program that writes updated code to the Flash ROM ch

When to configure the BIOS

BIOS configuration is necessary for first-time setup. Reconfigure the BIOS a
a BIOS or CMOS failure and recovery.

Requirements
� You need a bootable upgrade disk. For the Pentium III SBC, the Texas

Micro BIOS release number must be 4.06a.1.4a.

Contact your Nortel Networks customer representative to request a BIO
upgrade disk.

� You must perform both of the following procedures to upgrade the BIO

� upgrading the BIOS

� configuring the SBC

Before you begin

Change the position of DIP switch #3 on the SBC to the Closed or ON posi

To upgrade the BIOS

1 Insert the bootable BIOS upgrade disk into drive A and power on the server.

Note: You can obtain a BIOS upgrade disk from your Nortel Networks 
customer support representative.

2 Allow the flash process to complete.

3 Power down the system.

4 Remove the top cover.
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5 Set DIP switch 3 to the ON position.

6 Power on the server.

Result: A message appears on the boot screen that the system is loading 
BIOS defaults.

7 Power off the server after seeing the above message.

8 Return DIP switch 3 to the OFF position.

9 Replace the top cover.

10 Restart the system.

11 Configure the BIOS as described in the following procedure.

To configure the Pentium III SBC

1 Power on the system and press F2 to enter the CMOS Setup.

Note: For the following steps, use the arrow keys to navigate menus, and 
press Enter to make a selection.

Result: The Setup Utility starts. The screen has two areas:

� Options: The Options menu is on the left side of the screen, and is 
composed of Basic options, Advanced options, and PCI options.

� Summary Information: The current settings appear on the right side of 
the screen.

2 Select the items described in the tables that follow.
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Pentium III BIOS basic options

Note: The defaults must be loaded first.

Item Option Default setting CallPilot setting

Time and Date Set time and date N/A Current Date/Time

Floppy Disks Floppy Controller Enabled Enabled

Select drive A Type 3.5” 1.44 Mbytes 3.5” 1.44 Mbytes

Select drive B Type Disabled Disabled

IDE Adapter 0 Master CD-ROM CD-ROM

Slave None None

IDE Adapter 1 Master None None

Slave None None

Cache Memory Memory Cache Enabled Enabled

Cache System 
BIOS area

Write protect Write protect

Cache Video BIOS 
area

Write protect Write protect

Cache Base 0–512 
kbytes

Write back Write back

Cache Base 512k–
640 kbytes

Write back Write back

Cache Extended 
Memory area

Write back Write back

Cache A000–AFFF Disabled Disabled

Cache B000–BFFF Disabled Disabled

Cache C800–CBFF Disabled Disabled

Cache CC00–CFFF Disabled Disabled
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Cache D000–D3FF Disabled Disabled

Cache D400–D7FF Disabled Disabled

Boot Options Summary screen Enabled Enabled

Floppy check Enabled Enabled

Quiet boot Disabled Disabled

Post errors Disabled Disabled

Hard disk pre-delay Disabled Disabled

Keyboard features Numlock Auto Auto

Key click Disabled Disabled

Keyboard auto 
repeat rate

30/sec 30/sec

Keyboard auto 
repeat delay

1/2 sec 1/2 sec

System Memory Verify only

Extended Memory Verify only

Item Option Default setting CallPilot setting
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Pentium III BIOS advanced options

Item Option
Default 
setting CallPilot setting

Integrated 
Peripherals

Serial Port A Enabled Enabled

Serial Port A: Base
I/O Address

3F8 3F8

Serial Port A: 
Interrupt

IRQ 4 IRQ 4

Serial Port B Enabled Enabled

Serial Port B: 
Mode

Normal Normal

Serial Port B: Base
I/O Address

2F8 2F8

Serial Port B: 
Interrupt

IRQ 3 IRQ 3

Parallel Port Enabled Enabled

Parallel Port: Mode Bidirectional Bidirectional

Parallel Port: Base
I/O Address

378 378

Parallel Port: 
Interrupt

IRQ 7 IRQ 7

Floppy Disk 
Controller

Enabled Enabled

Floppy Disk 
Controller: Base 
I/O Address

Primary Primary

Local Bus IDE 
Adapter

Enabled Enabled
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Adaptec Ultra 
SCSI Adapter

Disabled Enabled for non-RAID

Disabled for RAID

Advanced 
Chipset Control

ECC 
ConfigDRAM 
Speed

ECC ECC

Enable Memory 
Gap

Disabled Disabled

Alias ISA 512 –528 
Mbytes

Disabled Disabled

DMA Aliasing Enabled Enabled

8-bit I/O Recovery 4.5 4.5

16-bit I/O 
Recovery

4.5 4.5

Watchdog Timer 
Status

Disabled Disabled

Watchdog Timer 
Delay

1.2 sec 1.2 sec

ISA bus GAT Disabled Disabled

PCI Delayed 
transactions

Enabled Enabled

PCI 
configuration

PCI IRQ Line 1 IRQ 9 IRQ 9

PCI IRQ Line 2 IRQ 10 IRQ 10

PCI IRQ Line 3 IRQ 11 IRQ 11

PCI IRQ Line 4 IRQ 15 IRQ 15

USB IRQ Enabled No No

Item Option
Default 
setting CallPilot setting
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Latency timer Auto Auto

Cache line size Auto Auto

ISA Graphics 
Device Installed

No Yes

PCI/PNP ISA 
UMB Region 
Exclusion
C800–DFFF

Available Available

PCI/PNP ISA IRQ 
Resource 
Exclusion:
IRQ3, IRQ4, IRQ5, 
IRQ7, IRQ9, 
IRQ10, IRQ11, 
IRQ12, IRQ14, 
IRQ15

Available

System 
Management

Verify Verify

PS/2 Mouse Enabled Enabled

On-board 
Speaker

Enabled Enabled

Use 
Multiprocessor 
Spec

1.1 1.4

Item Option
Default 
setting CallPilot setting
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Pentium III BIOS security options

CPU BIOS 
Update

Enabled Enabled

Plug & Play OS No No

Secured Setup 
Configuration

Yes Yes

Reset 
configuration 
data

No No

Large Disk 
Access Mode

DOS DOS

Item Option Default setting CallPilot setting

Supervisor 
Password is

Clear Clear

User Password is Clear Clear

Set Supervisor 
Password

Enter Enter

Set User Password Enter Enter

Item Option
Default 
setting CallPilot setting
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Pentium III BIOS power options

Password on Boot Disabled Disabled

Fixed Disk Boot 
Sector

Normal Normal

Disk Access Supervisor Supervisor

Virus Check 
Reminder

Disabled Disabled

System Backup 
Reminder

Disabled Disabled

Item Option Default setting CallPilot setting

Power Savings Disabled Disabled

Standby Timeout Off Off

Auto Suspend 
Timeout

Off Off

Hard Disk Timeout Disabled Disabled

Video Timeout Disabled Disabled

Resume on Modem 
Ring

Off Off

Resume on Time Off Off

Resume time 00:00:00 00:00:00

Item Option Default setting CallPilot setting
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Pentium III BIOS boot options

Pentium III BIOS server options

IRQ mapping table

Refer to “ IRQ mapping table” on page 192.

Default settings CallPilot setting

Diskette Drive Diskette Drive

Hard Drive ATAPI CD-ROM Drive

ATAPI CD-ROM Drive Hard Drive

Removable Devices Removable Devices

Network Boot Network Boot

Device Option

Hard drive Bootable add-in card

Removable Devices Legacy floppy drive

Item Option Default setting CallPilot setting

Console Redirect 
Port

Disabled Disabled

Console Redirect 
Baud Rate

9600 57600
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Dual Inline Memory Modules

Introduction

Dual Inline Memory Modules (DIMMs) SDRAM P100 are the memory 
modules located on the SBC. The gold-plated edge connectors on DIMMs a
designed to plug into matching edge-connector slots. The design allows you
add or remove these modules repeatedly without tools or damage. Install 
DIMMs on the Pentium III SBC only.

Capacity

Use 168-pin Error Correction Control (ECC) SDRAM utilizing DIMM 
technology. A module has a capacity of 32, 64, or 128 Mbytes or 256 Mbyte
SDRAM DIMMs require only one slot filled to compose a bank. There are tw
slots or banks on the SBC. Install DIMMs in any slot, combination, or order.
Nortel Networks recommends that bank 0 (DIMM 1) be filled to enable 
troubleshooting procedures. Install up to 512 Mbytes of memory. These are
P100 FSB SDRAM DIMMs.

Requirements

To add DIMMs to the card, you require the following:

� an antistatic wrist strap

� DIMMs with gold-plated edge connectors

To add SDRAM DIMMs to the SBC card

1 Remove the SBC card from the server.

Note: To remove old DIMMs, perform steps 2 and 3. To add new DIMMs, go 
to step 5.

2 Push the DIMM release tab outwards at both sides of the DIMM to be 
removed.
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3 Hold the DIMM by its edges, being careful not to touch its components. 
Remove the DIMM by lifting it away from its slot. Store it in an antistatic 
package.

4 Remove other DIMMs as necessary.

5 Orient the DIMM so that the two notches in the bottom edge of the DIMM 
align with the keyed slot.

6 Insert the bottom edge of the DIMM into the slot and press down firmly on 
the DIMM until it seats correctly.

When the DIMM seats correctly, release tabs lock back to an upright 
position. If the DIMM does not seat correctly, remove it and reinstall. Do not 
force the locking tabs to close.

7 Repeat the above two steps to install each additional DIMM.

8 Replace the SBC card in the server.

. 

CAUTION

Risk of equipment damage
When installing a DIMM in slot 1, the IDE locking latch 
might get in the way and cause a memory chip to snap 
out of the board.
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Section H: Adding and replacing switch-
specific boards and cards

In this chapter 
 Replacing MPB16 boards 252

 Adding a VoiceBridge 2000 card 260

 Replacing the VoiceBridge 2000 card 262

 Replacing the DTI/480SC board 264
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Replacing MPB16 boards

Introduction

This section describes replacing MPB16-4, MPB16-2T boards, and MPC-8
cards.

The parts to install

The MPB16 board comes in two different versions:

� MPB16-4 (for the Meridian 1, MSL-100/DMS-100, Lucent, Mitel, and 
Rolm switches)

� MPB16-2T (for the Matra switches)

MPB16-4 (NTRH20BA)
There are four slots available on the MPB16-4 (NTRH20BA) to hold four
MPC-8 cards.

There is also a DB-25 pin digital connector.

MPB16-2T (NTRH21CA) board
The MPB16-2T/LS*16 is a PCI form-factor card that includes two bays to h
MPC-8 DSP cards.

connector
DB-25

SCbus connector
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Note: The MPB16-2T/LS*16 is referred to as the MPB16-2T for the remaind
of this document.

Below is a picture of the MPB16-2T with analog mezzanine and two MPC-8
cards installed.

Analog loop start cable (NTRH0914)
The following photograph shows the 10-meter NTRH0914 analog loop start
cable. The DB-37 end connects at the back of the server to the MPB16-2T.
other end of the cable must be stripped and connected to a bix block servic
the Matra switch.
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CT-Bus cable (NTRH0915)
The CT-Bus ribbon cable is used to series two MPB16-2T cards in a single 
server. The connectors are keyed to optimize correct installation.

MPC-8 card
The MPC-8 is a credit card-sized PC card that plugs into all MPB16-2Ts. T
MPC-8 provides multimedia expansion to the MPB16-2T. Below is a picture
an MPC-8.

Maximum number of MPC-8s per server

The server supports up to a maximum of two fully loaded MPB16 boards, wh
provides 96 channels, or 64 channels (if the MPB16-2T board is used), as s
in the following table:
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Maximum number of MPB16-2Ts per server

The server supports up to a maximum of two fully loaded MPB16-2Ts, whic
provide 32 channels each for a maximum of 64 channels, as shown in the 
following table:

Maximum multimedia 
channels 

Optional MPC-8s

One MPB16-4 48
(16 of which are built into the 
MPB16-4 board) 

4
(provides up to 32 
additional channels)

Two MPB16-4s 96
(32 of which are built into the 
two MPB16-4 boards—16 
channels per board)

8
(provides up to 64 
additional channels)

One MPB16-2T 32
(16 of which are built into the 
MPB16-4 board) 

2
(provides up to 16 
additional channels)

Two MPB16-2Ts 64
(32 of which are built into the 
two MPB16-4 boards—16 
channels per board)

4
(provides up to 32 
additional channels)

Embedded multimedia 
channels 

Optional MPC-8s

One MPB16-2T 16 2
(provides up to 16 
additional channels)

Two MPB16-2Ts 32 4
(provides up to 32 
additional channels)
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Installing the MPC-8 cards

1 Slide the MPC-8 into any available bay on the MPB16-2T with the label side 
up. 

2 Press the MPC-8 gently into the bay until you feel the card slide firmly into 
place. If the card is placed in upside down, it will not slide completely into 
the bay.

Note: To simplify the installation, install the MPC-8 into the MPB16-2T prior 
to installing the MPB16-2T in the server.

Installing the MPB16-2T board

1 Remove the chassis cover.

2 Disconnect the CT-Bus cable from the existing MPB16-2T board.

3 Remove the existing MPB16-2T from its slot in the backplane. Retain the 
screw to reuse when installing the new board.

4 Press the MPB16-2T firmly into its slot in the backplane. 

Note: Take care to slide the MPB16-2T board carefully past the protective 
foil strips, as they are easily damaged.

. 

CAUTION

Risk of electrical damage
Wear an antistatic ESD wrist strap when handling 
multimedia processing boards and cables.

ATTENTION
Risk of system damage
MPC-8 cards are not hot-pluggable. Power down your serv
before installing the cards.

. 

DANGER

Risk of electrical shock
Disconnect the AC power and remove the AC power cord from t
host product.
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5 Secure the board at the rear of the server using the same screw you 
removed earlier.

6 If are installing a second MPB16-2T board, repeat steps 1 through 4.

7 If you have two MPB16-2Ts installed in the server, use the CT-Bus cable to 
connect the two boards. This cable is keyed; do not force the cable onto the 
card connectors.

8 Replace the server cover.

Note: Be careful not to pinch any cabling when sliding the server cover 
back on.

9 Connect the NTRH0914 loop start cable from the MPB16-2T board to the 
Matra switch. This cable connects to the punch-down panel servicing the 
Matra switch.

10 Run the Configuration Wizard to detect the new hardware.

Result: The MPB16 installation is complete.

DSP numbering

Use the following table as a guide for DSP numbering with multiple MPB16-
cards:

MPB16-2T board DSP assignments

First MPB16-2T 1 and 2 = embedded

3 and 4 = MPC-8

Second MPB16-2T 7 and 8 = embedded

9 and 10 = MPC-8
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MPC-8 cards are counted from the handle side of the MPB16-2T, as shown
the following photograph.

Installing the MPB16-4 boards

1 Remove the chasis cover.

2 Disconnect the SCbus cable from the existing MPB16-4 board.

3 Remove the existing MPB16-4 board from its slot in the backplane. Retain 
the screw to reuse when installing the new board.

. 

DANGER

Risk of electrical shock
Disconnect the AC power and remove the AC power cord from t
host product.

DSP 3DSP 4First MPB16-2T

DSP 9DSP 10

Second MPB16-2T
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4 Press the MPB16-4 boardfirmly into its slot in the backplane. 

Note: Take care to slide the MPB16-4 board carefully past the protective 
foil strips, as they are easily damaged.

5 Secure the board at the rear of the server, using the same screw you 
removed earlier.

6 If are installing a second MPB16-4 board, repeat steps 1 through 4.

7 Replace the server cover.

Note: Be careful not to pinch any cabling when sliding the server cover 
back on.

8 Run the Configuration Wizard to detect the new hardware.

Result: The MPB16 installation is complete.
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Adding a VoiceBridge 2000 card

Introduction

This section describes how to add a VoiceBridge 2000 Digital PBX/CBX 
integration card (also referred to as the VB2000 card). This card is installed
the server and supports connection to a Lucent, Mitel, or Rolm switch.

Types of VoiceBridge 2000 cards 

Note: These cards are identical in external appearance, and the procedures
installing and configuring them are the same.

The 1001rp can have a maximum of two VoiceBridge 2000 boards installed.
first board should be installed in ISA slot 1, and the new board in ISA slot 2
Refer to the picture on page 190 for the location of the ISA slots.

To install the VoiceBridge 2000 card

1 Shut down Windows NT and power down the server.

2 Remove the chassis cover.

3 Write down the serial number of the new VoiceBridge 2000 board.

Switch VB2000 card model Part number

Lucent 2-wire port type

Lucent Definity Generic 3 VB-2009 NTRH9060

Mitel

SX-200D, SX-200 Light, SX-2000 Light, 
SX-2000 S, SX-2000 VS

VB-2007 NTRH9059

Rolm

8000 CBX, 9000 CBX, 9751 CBX VB-2002 NTRH9057
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4 Remove the screw holding on the cover of the ISA slot and remove the 
cover.

5 Insert the VoiceBridge 2000 board and secure it with the screw.

6 Connect the SCbus cable so that it interconnects both of the VoiceBridge 
boards and the MPB16-4 board.

7 Replace the chassis cover.

8 Connect the external cable to the PBX connector on the back of the 
VoiceBridge 2000 board.

9 Restart the server and log on to Windows NT.

10 Run the VTG Configuration application (d:\nortel\bin\vtgconfiguration.exe).

11 Click ADD.

Result: The Add Board dialog box appears.

12 Enter the serial number of the new VTG board and click OK.

13 Click Close.

Result: The VTG Configuration closes.

14 Run the Configuration Wizard to reconfigure the VTG channel 
configuration.

The VoiceBridge 2000 card installation is complete.
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Replacing the VoiceBridge 2000 card

Introduction

This section describes replacing the VoiceBridge 2000 Digital PBX/CBX 
integration card (also referred to as the VB2000 card). This card is installed
the server and supports connection to a Lucent, Mitel, or Rolm switch.

Types of VoiceBridge 2000 cards

 

Note: All these cards are identical in external appearance, and the procedur
installing and configuring them are the same.

To install the VoiceBridge 2000 card in the server

1 Disconnect the external cable from the VoiceBridge2000 card.

2 Remove the chassis cover.

3 Disconnect the internal SCbus cable from the VoiceBridge2000 card.

4 Remove the existing VoiceBridge 2000 card from its ISA slot.

5 Remove the new VoiceBridge 2000 card from its ESD bag. 

Switch VB2000 card model Part number

Lucent 2-wire port type

Lucent Definity Generic 3 VB-2009 NTRH9060

Mitel

SX-200D, SX-200 Light, SX-2000 Light, 
SX-2000 S, SX-2000 VS

VB-2007 NTRH9059

Rolm

8000 CBX, 9000 CBX, 9751 CBX VB-2002 NTRH9057
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6 Write down the VoiceBridge 2000 card serial number, which is printed on 
the backplate of the card, and the slot number. The serial number is shown 
as “S/N: xxxxx.” 

7 Insert the VoiceBridge 2000 card into the ISA slot. The PBX connector 
should be positioned in the open slot in the backplane.

8 Replace and tighten the retaining screw to secure the board. 

9 Repeat steps 2 to 4 for each VoiceBridge 2000 card.

10 The SCbus cable consists of two connectors at one end (intended for the 
MPB16-4s), a large gap with no connectors, and then seven connectors at 
the other end (intended for the VoiceBridge 2000 cards). 

Use the SCbus cable to connect the MPB16-4 and VoiceBridge 2000 cards.

11 Put the cover back on the server.

Note: Be careful not to pinch the SCbus cable when sliding the server 
cover back on.

12 Power up the server and log on to Windows NT.

13 Run the VTG Configuration application (d:\nortel\bin\vtgconfiguration.exe).

14 Select the serial number of the board that was removed and click Delete.

15 Click ADD.

Result: The Add Board dialog box appears.

16 Enter the serial number of the new VTG board and click OK.

17 Click Close.

Result: The VTG Configuration closes.

18 Run the Configuration Wizard to reconfigure the VTG channel 
configuration.

Result: The VoiceBridge 2000 card installation is complete.
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Replacing the DTI/480SC board

Introduction

This section describes replacing the DTI/480SC board. The DTI/480SC boa
provides a T1 network interface to the switch. 

Switch settings

� Board locator switch (SW100)

Switch SW100 is used to assign the unique board locator ID. The 
installation procedure instructs you to assign a unique board locator ID
each board.

� Remote Loopback Switch

The loopback switch is factory-set to ON for normal mode. You can mo
the loopback switch to the OFF position for loopback mode as part of 
troubleshooting a system problem.
264 CallPilot



May 2000 Performing hardware maintenance 
DTI/480SC board - switch locations

Installing the DTI/480SC boards

1 Remove the chassis cover.

2 Remove the existing DTI/480SC from its ISA slot in the backplane. Retain 
the screw to reuse when installing the new board.

3 Remove a DTI/480SC board from its ESD bag. 

G101466

P4

Dual RJ-48C
jacks

SW100

Red

Span 1 Span 1 Span 1

Loopback
LED

Loopback
switches

Status
lights

Span 2

Yellow
Green

Loopback
switches

Normal mode
Default

Loopback
switches

Remote loopback
mode

ON

ON
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4 On the board, dial the rotary switch (SW100) to select a number. Set the 
first board to 0, the second to 1, and so on. 

The switch has hexadecimal numbers ranging from 0 to F inclusive. See 
“DTI/480SC board - switch locations” on page 265.

5 Ensure that the loopback switch is in the ON (down) position. See “DTI/
480SC board - switch locations” on page 265.

6 Use the slot’s board guides as you insert the board edge connector into the 
slot. Press firmly until the board is securely seated in the slot.

7 Replace and tighten the retaining screw to secure the board. 

8 Repeat steps 2 to 7 for each DTI/480SC board you are installing.

9 Use the SCbus cable to connect the MPB16-4 and DTI/480SC boards. See 
“DTI/480SC board - switch locations” on page 265 for the location of the P4 
connector.

The SCbus cable consists of two connectors at one end (intended for the 
MPB16-4s), a large gap with no connectors, and then seven connectors at 
the other end (intended for the DTI/480SC boards).

10 Put the cover back on the server.

Note: Be careful not to pinch the SCbus cable when sliding the server 
cover back on. 

11 Run the Configuration Wizard to detect the new hardware. 

Result: The board installation is complete. 
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Section I: Media drive bay

In this section
 About the media drive bay 268

 Removing drive carriers from the media drive bay 269

 Replacing a drive in the media bay 274
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About the media drive bay

Overview

Media drive bays contain media devices, including CD-ROM and tape and 
floppy drives. If your media drives become damaged or you want to upgrad
you can replace these drives. This section provides procedures for replacin
upgrading any device in the drive bay.

Procedures

Perform the procedures for replacing media devices in the following order:

1. removing drive carriers

2. removing media drives

3. Replacing a drive in the media bayr
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Removing drive carriers from the media drive 
bay

Introduction

When replacing the media hard drives, the first step is to remove the drive 
carriers from the drive bay. Each drive carrier holds one media drive.

Requirements

To remove the drive carrier from the media drives, you require the following

� keys for the front bezel doors

� a Phillips screwdriver

� cable identification labels

� a pen or pencil

Locate the media drives

Media drives are located at the front of the chassis, below a cooling fan, an
beside the hot-swappable SCSI drive bay. Access installed media devices 
through the key-lock media door.
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The media drive bay

Media carrier 

The media drive houses up to four devices. A drive carrier holds each devic
Where no device is installed, a blank panel is secured to the drive carrier fo
protection.
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Media carrier slot assignment

The carrier is designed to stack three devices horizontally, and to house the
floppy drive vertically to the right side of the carrier frame. The following 
illustration shows the orientation of the drives, and the standard slot assign
for each of the required devices:

To remove device carriers from the media drive bay

1 Remove the front bezel from the chassis.

2 Locate the media drive, and loosen the four Phillips-head screws and 
washers securing the carrier to the drive bay.

. 

DANGER

Risk of electrocution
High current inside the chassis can cause severe injury.

. 

CAUTION

Risk of equipment damage
Electrostatic discharge due to improper handling can cau
components to be damaged or rendered unusable.

������

 ��� �����

!
��" ����
 �
��
�
�
�
�
�	


�
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3 Holding cables away from the drive bay, pull the carrier away from the 
chassis until the connectors attached behind the components can be 
reached.

4 Label and disconnect cables from installed media drives, and then free the 
carrier from the chassis.

. 

CAUTION

Risk of equipment damage
Cables can be easily damaged during this procedure. Ch
that no cables are crossed when moving the carrier in and
of the drive bay.
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See also
� Removing and installing the front bezel

� Configuring and replacing hard drives

What’s next?

Once you have removed the device carriers from the media drive bay, remov
media drive devices. 
Part 5: 1001rp Server Maintenance and Diagnostics 273



Performing hardware maintenance  Standard 1.0

dia 
Replacing a drive in the media bay

Introduction

The third step in replacing a media drive is to install the new drive in the me
bay.

Requirements

To install media drives into the carrier, you require the following:

� a Phillips screwdriver

� four screws from the previous procedure

� keys for locking the front bezel

To install a drive in the media bay

1 Slide the new drive into the drive carrier, and secure it with four undercut 
Phillips-head screws. 

2 Reattach the removed devices to access a specific drive slot.

3 Position the carrier to the drive frame, leaving enough room to reach behind 
the carrier, and attach the connectors.

4 Carefully connect the device and power cables, and then slide the carrier 
into the drive bay, checking that the cables are free and undamaged.

Note: If your tape drive is a narrow device, you require a wide to narrow 
adapter to connect to the wide SCSI cable.

5 Secure the carrier to the chassis with four Phillips-head screws.

6 Replace and lock the front bezel.
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Recovering from a hard drive failure 
or corrupted software

In this chapter
 Overview 414

 Recovering from a hard drive failure in a RAID system 415

 Recovering from a hard drive failure 416
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Overview

Introduction

If the CallPilot server hard drive crashes or if software becomes corrupt, the
you must either reinstall the software or rebuild the hard drive. 

Reinstalling languages

If only the language prompts are not functioning, then you can reinstall 
languages to try to fix the problem. See “Reinstalling languages” on page 412.

Recovering from corrupted software (hard drive is functioning)

If the hard drive is functioning but the CallPilot software appears to be 
corrupted, you can reinstall the CallPilot server software. This might correct
problem. See “Reinstalling the software (hard drive is functioning)” on page 
406. If it does not correct the problem, then you need to rebuild the hard dri

Recovering from a hard drive failure in a RAID system

The 1001rp server is a RAID system. 

In a RAID system the hard drives are mirrored. When one hard drive fails, i
secondary hard drive takes over and there is no system down time. Howeve
need to replace the faulty hard drive as soon as possible to maintain hard d
redundancy. See “Recovering from a hard drive failure in a RAID system” on 
page 415.

Note: If both the hard drives in a mirrored pair fail, then you need to restore
primary hard drive as described in “Recovering from a hard drive failure” on 
page 416.

ATTENTION Contact your distributor if a hard drive recovery is required.
414 CallPilot
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Recovering from a hard drive failure in a RAID 
system

Introduction

The 1001rp server is a RAID system. 

In a RAID system the hard drives are mirrored. When one hard drive fails, i
secondary hard drive takes over and there is no system down time. Howeve
need to replace the faulty hard drive as soon as possible to maintain hard d
redundancy.

Note: If both the hard drives in a mirrored pair fail, then you need to restore
primary hard drive as described in “Recovering from a hard drive failure” on 
page 416.

To recover from a hard drive failure in a RAID system

Follow the instructions in the hardware maintenance chapter to replace the f
hard drive and rebuild the new hard drive. 
Part 5: 1001rp Server Maintenance and Diagnostics 415



Recovering from a hard drive failure or corrupted software Standard 1.0

 

 

rver 

ot 
t 
t 
Recovering from a hard drive failure

Introduction

Contact your distributor if a hard drive fails. Your distributor has access to a
utility that is required to restore data from a backup tape. If this is a RAID 
system and both drives in a mirrored pair fail, then you need to restore from
backup tape. If only one drive in a mirrored pair fails, see “Recovering from a 
hard drive failure in a RAID system” on page 415.

Requirements
� all software media that came with the CallPilot system

� a complete set of server backups, including

� a system backup

� one secondary disk backup for each additional disk drive on your se
(for example E:, F:)

ATTENTION The recovery procedure requires access to a utility that is n
available to customers. Distributors should refer to the lates
General Release Bulletin on the Nortel Networks web site a
http://www.nortelnetworks.com/nic for the latest procedure.
416 CallPilot
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boot sequence�29
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chassis keys�155
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Windows NT 4.0�53��56��58��60��62��64��65��72��
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chkdsk utility�53
commands

arp�61
ipconfig�55
nbstat�63
Net Start�78
Net Stop�71
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ping�57
tracert�59
TSTSERIO�73��74��76��77

component
viewing states�103

conductive foam pads�23
configure the Pentium II SBC�222��240
configuring hard disk drives�182
Conventions used in guide�17
cooling fans�157

D
DAC Administration�185
DAC Administration software�184
DACAdmin software utility�188
device�191
Diagnostic tab of Maintenance window�93
diagnostic tools

ping�67
TSTSERIO tests�73��74��76��77
Windows NT 4.0�50

diagnostics�31
beep codes�29
Event Viewer�52
from the administrative PC

running�110
viewing last results�113

interpreting�45
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serial port
overview�70

TCP/IP�55
token ring card�67
Windows NT 4.0�49

Dialogic software, installing�360
DIMM �218��237
DIMM slots on a Pentium II SBC�232
DIP switch block on the Pentium II SBC�221
DMS-100

installing switch software�360
doors on the front bezel�152
DTI/480SC board�264

installing�265
Dual Inline Memory Modules (DIMMs)�232��

249

E
ELAN cards�201
ELAN network card driver�202
electrostatic discharge�23
emergency start-up disk�325
error messages�45
Ethernet card�206
Ethernet CLAN cards�206
event logs�52
Event Viewer�52
expanding

features�396

F
fan�160
field replaceable units�113
front bezel�152��153
fuse�163

G
general safety�22
General tab of Maintenance window�93

H
handling�26
hard disk�178
hard disks�188��295
hard drive�161��179��182
hard drive bay�180��181
hard drive failure�185
hardware�145

diagnostics
Windows NT 4.0�49

hardware problems
how to isolate and fix�84
indications of�83

hot-swappable components�157��173

I
installing�276

CallPilot server software�330
Dialogic software�360
DTI/480SC board�265
pcANYWHERE32

overview�306
VoiceBridge software�348

integrated diagnostics
running�110

Intel PCI Ethernet card�207
interpreting diagnostics�45
ipconfig command�55
IRQ�192��210
IRQ mapping table�192

J
jumper block�168
jumper block locations�218

L
Last Result button�99
LED�159
logs�52
Lucent
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installing switch software�348

M
Madge ISA Token Ring card�211
maintenance activities�19
Maintenance tab of Maintenance window�93
Maintenance window

description of�93
purpose�92

materials checklist�20
Memory Address�210
Mitel

installing switch software�348
MSL-100

installing switch software�360

N
nbstat command�63
Net Start command�78
Net Stop command�71
netstat command�65
Network Address�210
Network Control Panel�202

P
pcANYWHERE32

installation overview�306
video mode

pcANYWHERE32
�����������318

PCI ethernet card�206
Pentium II BIOS advanced options�226��243
Pentium II BIOS basic options�223��241
Pentium II BIOS power options�230��248
Pentium II BIOS security options�229��246
Pentium II BIOS server options�231��248
Pentium II SBC�218��237
Pentium II slot assignment�191
Pentium MMX SBC card�177
Pentium MMX slot assignment�191
Performance enhancement packages (PEPs)

identifying types�338
installation procedure�339
readme files�339
running a system backup�338
shutting down services�342
using the DMI viewer�342

Ping command�57
token ring diagnostics�67

POST
See Power-On Self Test (POST)�29

POST code�39
POST error codes and messages�39
POST message formats�37
Power Down button�97
power supply�157��158��159
Power Up button�97
powering up�29

boot sequence�29
precautionary messages�17

R
Racore PCI Token Ring card�209
RAID�173

errors�188
RAID card�157��174��176��177
RAID hard drives�188
RAID level 1�173��184
RAID SCSI hard drive configuration�180
RAID system�178
rebuilding a hard disk in RAID�184
Redundant Arrays of Inexpensive Disks (RAID�

173
reinstalling

CallPilot server software�406
languages�412

remote loopback switch
DTI/480SC board�264

replacement part numbers
obtaining�116

Replacement tab of Maintenance window�93
replacing hard drives�179
requirements

start-up diagnostics�45
restarting system after TSTSERIO tests�78
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S
safety precautions�20
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diagnostics�45
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SCSI ID�180��181
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serial port

diagnostics�70
server

boot sequence�29
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startup�29

set SCSI IDs�181
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services�71
slot�191
slot/device�192
SQLAnywhere�30
startup

server�29
start-up sequence�29
status display�170
Structure�16
switch settings

DTI/480SC board�264
Symbols used in guide�17
symbols used in guide�17
system

restarting after TSTSERIO tests�78
turning on�29

System Information utility�134
system logs�52
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T1 interface�264
tape device driver�300
tape drive�178

TCP/IP
diagnostics�55

Token Ring CLAN cards�209
tools�20
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U
uninstalling

CallPilot server software�403
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Meridian 1 software�401
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upgrade the BIOS�221��239
upgrading

CallPilot software on the server�375
pre-upgrade checklist�376
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utilities
System Information�134

utility
chkdsk�53

V
video card�195��196
video mode, configuring for pcANYWHERE32�

318
viewing

general information about components�101
VoiceBridge software�348

W
Warning messages�17
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weekly maintenance�188
While�23
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